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Legal notes 

© 2019 ISD ® Software und Systeme GmbH. All rights reserved. 

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in 
accordance with the terms of the license. The contents of this User Guide solely serve the purpose of information; it may be 
modified without prior notice and may not be regarded as binding for the ISD Software und Systeme GmbH. The ISD Software und 
Systeme GmbH does not assume any responsibility for the correctness or accuracy of the information provided in this document.  No 
part of this document may be reproduced, saved to databases or transferred in any other form without prior written permission by 
the ISD Software und Systeme GmbH, unless expressly allowed by virtue of the license agreement.   

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers. 

 

The license management portion of this Licensee Application is based upon one or more of the following copyrights: 

Sentinel®RMS   
© 1989-2019 SafeNet, Inc.  
All rights reserved. 

Sentinel®EMS™  
© 2008-2019 SafeNet, Inc.  
All rights reserved. 

Sentinel® is a registered trademark of SafeNet, Inc.  

 

This work contains the following software owned by Siemens Industry Software Limited: 

D-CubedTM 2D DCM © 2019. Siemens Industry Software Limited. All Rights Reserved. 

D-CubedTM 3D DCM © 2019. Siemens Industry Software Limited. All Rights Reserved 

D-CubedTM AEM © 2019. Siemens Industry Software Limited. All Rights Reserved. 

 

PDF3D® 

© 2003-2019 Visual Technology Services Ltd. All rights reserved. Is a registered trademark of Visual Technology Services Ltd.   

 

Copyright 2008, Google Inc. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions 
are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 

* Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote products derived from this 
software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

Code generated by the Protocol Buffer compiler is owned by the owner of the input file used when generating it. This code is not 
standalone and requires a support library to be linked with it.  This support library is itself covered by the above license. 

 

Lp_solve 

HiCAD uses the library lp_solve.  

lp_solve is a free library under the LPGL license (Lesser Public General License) of the Free Software Foundation. 

Details on the licensing can be found at http://lpsolve.sourceforge.net/5.5/LGPL.htm  

http://lpsolve.sourceforge.net/5.5/LGPL.htm
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Autofac, Copyright (c) 2019 Autofac Project 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the 
"Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject 
to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

 

Castle.Core, Copyright 2004-2019 Castle Project 

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. 
You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law or agreed to 
in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF 
ANY KIND, either express or implied. See the License for the specific language governing permissions and limitations under the 
License. 

 

Apache log4net, Copyright 2004-2019 The Apache Software Foundation 

This product includes software developed at The Apache Software Foundation (http://www.apache.org/). Licensed under the Apache 
License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the 
License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law or agreed to in writing, software 
distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied. See the License for the specific language governing permissions and limitations under the License. 

 

NHibernate, Copyright (c) The NHibernate Project 

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as 
published by the Free Software Foundation (version 2.1). This library is distributed in the hope that it will be useful, but WITHOUT 
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the 
GNU Lesser General Public License for more details. You should have received a copy of the GNU Lesser General Public License 
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 
USA 

 

Fluent NHibernate, Copyright (c) 2008-2019, James Gregory and contributors 

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 

* Neither the name of James Gregory nor the names of its contributors may be used to endorse or promote products derived from 
this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

 

http://www.apache.org/licenses/LICENSE-2.0
http://www.apache.org/
http://www.apache.org/licenses/LICENSE-2.0


 

 4 UNLIMITED PERFORMANCE 

EPPLUS 

HiCAD uses the EPLUS library. This is a free library which is licensed under the terms of the GNU Lesser General Public License as 
published by the Free Software Foundation. 

Further information on the licensing can be found under http://epplus.codeplex.com/license 

 

FreeType 

Portions of this software are copyright protected © 2019 The FreeType Projekt (www.freetype.org). All rights reserved. 

 

FreeImage 

HiCAD uses the FreeImage open source image library. FreeImage is used under the FreeImage Public license (FIPL).  

Further information can be found at http://freeimage.sourceforge.net. 

 

 

 

 

http://epplus.codeplex.com/license
http://freeimage.sourceforge.net/
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1 Before beginning the installation! 
 

Discontinuation of Windows 7 

Microsoft will cease the support for Windows by January 2020. Due to compability matters HiCAD 2020 SP1 
and HELiOS 2020 SP2 will thus be the final versions of our CAD and PDM systems which support Windows 
® 7. The corresponding server operating systems (Windows Server 2008 R2 or older) will then no longer be 
supported either. 

 

Discontinuation of “old“ HiCAD itemisation 

As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be 
available for model drawings that were already itemized with these functions. From HiCAD 2020 onwards, 
only the “new” itemization will be supported.  

The itemisation by assemblies (the Within assembly, ... options in the old Itemisation dialogue) will only be 
supported by the new Standard Itemisation as of HiCAD 2019 SP1. If you want to use these options, you 
should update to SP1 first. 

 

Saving REF3D ATTR AKT.DAT 

Up to HiCAD 2017, the settings for the attribute synchronisation were determined in the system file 
REF3D_ATTR_AKT.DAT.  

In case if you want to take over settings from an existing REF3D_ATTR_AKT.DAT, this is possible in the 
configuration management. The default settings are being overwritten with said file.  

In case if you have made specific settings in the file REF3D_ATTR_AKT.DAT, save the file beforehand. 

 

Current system requirements 

Current information and Whitepaper for system requirements can be found at ISD Wiki. 

 

Changed licensing 

The HiCAD ALUCOBOND exclusiv Standard and HiCAD ALUCOBOND exclusiv Premium modules are no 
longer available from HiCAD 2019 onwards. The two modules HiCAD ALUCOBOND Suite Standard and 
HiCAD ALUCOBOND Suite Premium (previously HiCAD ALUCOBOND hybrid Standard and HiCAD 
ALUCOBOND hybrid Premium) are available as replacements. 

The module Steel/Metal Engineering is not available as of HiCAD 2018. The modules HiCAD Steel 
Engineering and Metal Engineering are available as an alternative. 

 

FIG turns into FGA 

HiCAD 2017 came with the new 2-D figures archives with the file name extension .FGA. Please use only this 
new .FGA format for conversion of existing 2-D .FIG files! For this purpose, use the new 
Converter_FIG_To_FGA.exe tool in the HiCAD\exe directory.   

When updating from HiCAD 2016 or older, all standardly supplied 2-D parts (e.g. drawing frames) in the 
different installation directories will be converted from FIG to FGA by default during the installation. The data 
in the original state will be saved in a folder (resp. a ZIP archive) in the scene and catalogue directory. The 
converted files will be documented in a LOG file.       

When creating an interface between HiCAD and HELiOS, you will be prompted to update the databases after 
a new installation or an update installation. The search for and management of 2-D parts will only be 
possible after conversion of the database and the existing .FIG files with the above mentioned tool. 

https://wiki.isdgroup.com/pages/viewpage.action?spaceKey=wpaper&title=Whitepaper
https://wiki.isdgroup.com/pages/viewpage.action?pageId=32374802
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Licences 

We recommend deactivating local licenses and network licenses before performing an update/upgrade of 
the operating system (e.g. from Windows 8 to Windows 10), and activating them again after successful 
update/upgrade of the operating system. 

 

Data Format 

HiCAD 2019 (Version 2400) uses a different data format, i.e. .SZA files created with HiCAD 2019 cannot be 
loaded in older HiCAD versions.  
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2 System Requirements 
2.1 Hardware Requirements for HiCAD 
It is possible to obtain our software with workstations and monitors as end-to-end solution. Thus, it is 
ensured that with the right configuration you get the most out of our software. As a matter of course, we 
undertake site installation of the software and customize these in accordance with heterogeneous system 
environments of common products. No matter how you decide: It is up to you which hardware components 
are to be used.  

 

Hardware requirements (minimum) 

Computer Generally, all hardware can be used enacting current drivers of applicable 
OS. 

Please note that for instance the graphic-card drivers support OpenGL 
command sequence. 

Internet connection and adrive for the installation medium 

Processor (CPU): Intel or AMD processor with SSE2 support 

RAM: 4 GB RAM 

Hard disk: approx. 10 GB free disk space 

Screen resolution 1280 x 1024 

Graphics card: Fully OpenGL 2.0 capable graphics card with at least 128 MB memory. 
You can use the OpenGLCapabilityTester to check whether the OpenGL 
capabilities of your computer are sufficient for HiCAD.  

Other: For the output of reports, e.g. Sheet Metal cost calculations, you require 
Microsoft Office Version 2010 or higher. 

 To achieve optimal performance for large assemblies, the system should possess significantly more main 
memory than is considered sufficient for HiCAD at first glance. This enables the hard disk accessing operations 
Buffer memory, Undo and Switch drawing to be performed up to 4 times faster. 

» Supported database systems (for HiCAD with HELiOS): 

 Microsoft SQL Server 2008 / 2012 / 2014 / 2016 / 2017 

 Oracle Database Server 11g R1 / 11g R2 / 12c 

There are no further requirements for the installation of the HiCAD Version with License Management; the 
legal licensing check is performed during runtime.  

 

https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe?version=1&modificationDate=1346699841077
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Example of a suitable hardware equipment for HiCAD (July 2019) 

Computer: Fujitsu Desktop ESPRIMO P958/power 

Processor (CPU): Intel® Core™ i7-9700-Processor, 12 MB, 3.00 GHz to 4.7 GHz or 

equivalent processor 

SingleCore Benchmarks that can be found on various websites may help you 
with the choice of the processor. 

An example: https://www.cpubenchmark.net/singleThread.html 

RAM: 4 x 8 GB, DDR4, 2.400 MHz, (incl. ECC) 

If you work with very large CAD drawings it could be recommendable to use 
computers with more RAM.  

Hard disk: 1 x 512 GB, SSD SATA III Premium bay, 2,5 inch 

Graphics card: NVIDIA Quadro P1000 (4 GB) or AMD WX3100 (4 GB) 

Screen resolution Full HD (1920x1080) 

Operating system: Microsoft Windows 10 (64 Bit)  

Other: Microsoft Office Version 2010 or higher. 

 Please note: 

 For the connection to Sentinel License Server, the Firewall of the UDP Port 5093 License Server must 
be released for in- and outcoming connections; for the Windows Firewall, the port release is executed 
automatically by activating the respective option in the installation program of the License Server.   

 Network licenses can be used under the hardware requirements for the OS prescripted by the License 
Server. 

 Internet access is necessary for the computer/server administrating the licenses! 

 In addition, a database under the hardware requirements for HELiOS is necessary when using HELiOS. 
Please note that insufficient graphics hardware will impair the performance and the quality of 
graphical representation. 

 

https://www.cpubenchmark.net/singleThread.html
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2.1.1 Compatibility Matrix for Interfaces 
The list below contains an overview of the interfaces that are availaible for HiCAD: 

 

 HiCAD 2019 HiCAD 2018 HiCAD 2017 

Operating system    

Windows 10, 64 Bit    

Windows 8.1, 64 Bit    

Windows 8, 64 Bit    

Windows 7, 64 Bit    

PDM system    

HELiOS 2019    

HELiOS 2018    

HELiOS 2017    

HELiOS 2016    

Interfaces    

LogiKal 11    

LogiKal 10    

LogiKal 9    

PartSolutions 10.0    

PartSolutions 9.8    

PartSolutions 9.7    

PartSolutions 9.5    

PartSolutions 9.0    

PartSolutions 8.0    

KISSoft 03/2017 -  03/2014    

CADClick 3.0    

Microsoft Office * 
* Limitations may occur in conjuction with VBA. 

  
 

Office 2016    

Office 2013    

Office 2010    

Browser    

Internet Explorer 9 - 11    

Edge    

Mozilla Firefox 31 - 60    

Google Chrome 37 - 66    
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2.2 System Requirements HiCAD Spooler 
The system requirements for Spooler are identical to those for a normal HiCAD Client (please see System 
Requirements for HiCAD). The RAM should be at least as large as the RAM for the existing HiCAD Clients. 
The reason for this is that the Spooler must be able to perform, besides automation tasks, various other 
tasks such as the conversion of HiCAD drawings (to 3D-PDF or similar).The HiCAD Spooler runs on a 
separate Plot Server System. 

In a combined operation of HiCAD and HELiOS, the HiCAD Spooler is driven by HELiOS Spooler. You can 
find further instructions for installing HELiOS Spooler running on the same system as the HiCAD Spooler in 
HELiOS Help.  

Besides the Client operating systems Windows 7, 8 and 10 you can also use the Server operating systems 
Windows Server 2008 or Windows Server 2012. Whether a Server operating system needs to be used 
depends on the licensing conditions for the Microsoft operating system that you use. The decisive factor is 
the number of permitted simultaneous device connections. 

» Windows 7, 8 and 10 allow 20 simultaneous connections. This will be sufficient for 20 Print Clients, if all 
of them are actually running at the same time. Please note however that each connection from a non-
HiCAD/HELiOS workstation will reduce this number. 
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2.3 System Requirements HELiOS Database 
The requirements with regard to the hardware primarily depend on the specifications given by the respective 
RDBMS supplier (Microsoft / Oracle). Currently, the support is as follows:  

 

 
HELiOS 2019 HELiOS 2018 HELiOS 2017 

Microsoft SQL Server 2019    (as of SP2) 

Microsoft SQL Server 2017   (as of SP2)  

Microsoft SQL Server 2016    

Microsoft SQL Server 2014    

Microsoft SQL Server 2012    

Microsoft SQL Server 2008    

Microsoft SQL Server 2005    

Oracle Database Server 12c    

Oracle Database Server 11g R2    

Oracle Database Server 11g R1    

Oracle Database Server 10g    

 

In addition, the following minimum requirements should be guaranteed for the main memory and hard disk: 

 

 HELiOS 2019 HELiOS 2018 HELiOS 2017 

Main memory Additionally at least 4 GB main memory. 

With an increasing database size the working memory should be enlarged in 
order to guarantee optimal performance. 

Hard disk Additionally at least 10 GB free hard disk memory. 

The factual demand depends on the size of the database. 

 

 Please note: 

 The use of virtual servers is essentially possible. Please consider to grant sufficient performance within 
the virtual environment. 

 On the database server, a HELiOS data base should be imported beforehand, for example via HELiOS 
Database Creator, so that clients can connect with the database. 

 SQL Server Standard vs. SQL Server Express 

 As of late, the productive use of SQL Server Express is possible. Please note that SQL Express has 
limited storage size (10 GB) for each data base and provides weaker performance than SQL Standard, 
especially on powerful hardware.  
 

If well-equipped hardware is used for the server (multiple processors and plenty of RAM), the SQL 
server thwarts the performance again. On regular desktop hardware the difference between SQL 
Express and SQL Standard is smaller due to the accordance of express limits and system. 
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2.4 Hardware Requirements HELiOS Vault Server 
The HELiOS Vault Server can either be installed as 32-Bit or 64-Bit application. The minimum requirement 
is as follows:  

 

 HELiOS 2019 HELiOS 2018 HELiOS 2017 

Processor (CPU) X86 or AMD64 Architecture with SSE2 Support 

Main memory Additionally at least 1 GB main memory 

Hard disk The needed hard disk space depends on the volume of arising data use (files). 
A safety margin should be considered. 

Operating system Microsoft Windows 7 or Microsoft Windows Server 2008 R2 or higher 

 

 Please note: 

 Only if you work with interfaces to HiCAD and/or Microsoft Office, the use of HELiOS Vault Servers is 
optional. Other interfaces must be used with HELiOS Vault Server. 

 The needed hard disk space can also be distributed on multiple volumes. 

 We recommend the use of RAIDs in order to provide failsafe performance. 
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2.5 Hardware Requirements HELiOS Desktop (Standalone) 
The HELiOS Client can either be installed as 32-Bit or 64-Bit application. The minimum requirement is as 
follows: 

 

 HELiOS 2019 HELiOS 2018 HELiOS 2017 

Processor (CPU) X86 or AMD64 Architecture with SSE2 Support 

Main memory Additionally at least 2 GB main memory 

Hard disk Additionally at least 2 GB free hard disk memory 

Operating system Microsoft Windows 7 or Microsoft Windows Server 2008 R2 or higher 

 

 Please note: 

 When coupling HELiOS Clients with other applications, for instance with a CAD system or Office product, 
please consider the minimum requirements of each system supplier as well. 

 When using integrated viewer, the hardware requirements of respective viewer manufacturer should be 
considered 

 Before commissioning HELiOS Client, you need HELiOS Datenbankserver (cf. 2.1) as well as a respective 
configurated ODBC connection. 
You will find documents (im .pdf-Format) for installing the data base system and import and export of 
database via ISD Wiki at Product Know-how > Documentation > HELiOS.  

 Current information for hardware requirements can be found via www.isdgroup.com at Support > ISD 
Wiki > Product know-how > FAQ. 

 

https://wiki.isdgroup.com/display/Heliosdoc/HELiOS+Documentation
file:///D:/240X/docs/englisch/Handbuecher/InstallationHiCAD/www.isdgroup.com
https://wiki.isdgroup.com/display/FAQ/FAQ+-+Frequently+asked+questions
https://wiki.isdgroup.com/display/FAQ/FAQ+-+Frequently+asked+questions
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2.6 Hardware Requirements HELiOS Spooler 
HELiOS Spooler is in principle a 64 Bit application. The same system and hardware requirements as for 
HELiOS Client are applicable:  

 

 HELiOS 2019 HELiOS 2018 HELiOS 2017 

Processor (CPU) AMD64 Architecture with SSE2 support 

Main memory Additionally at least 2 GB main memory 

Hard disk Additionally at least 4 GB free hard disk memory 

Operating system Microsoft Windows 7 or Microsoft Windows Server 2008 R2 or higher 

 

 Please note: 

 HELiOS Spooler runs on a separate Plot Server System. 

 HELiOS Spooler requires locally installed CAD, electrical engineering or Office applications for that plot 
and conversion orders are carried out. Please note that the use of these applications requires 
respective licenses and that the hardware requirements of each system supplier must be considered as 
well. 

 The main memory should be at least dimensioned as large as the main memory of the client system 
deployed. Thus it is guaranteed that the data (can be processed accordingly by HELiOS Spooler.  

 Besides the client operating systems for Windows, the above mentioned server operating systems can 
be used as well. It depends on the license terms for the Microsoft OS used by your company whether a 
server operating system can be used or not. Here, the number of permitted simultaneous connections 
is deciding here. 

As of Windows 7, 20 simultaneous logins are approved. In this case, you need to assure that apart from 
the current logins sufficient logins are available for each Client computer’s Print Client. 
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2.7 Hardware Requirements License Server 
We use the Software Sentinel RMS© from gemalto© for licensing. The license server is in principal a 32 Bit 
application. 

The minimum requirement for running a license server is as follows: 

 

 HELiOS 2019 HELiOS 2018 HELiOS 2017 

Processor 
(CPU) 

X86 or AMD64 Architecture. 

Recommended: 2 GHz processor 

Main memory Additionally at least 1 GB main memory 

Hard disk Additionally at least 2 GB free hard disk memory 

Operating 
system 

Microsoft Windows 7 or Microsoft Windows Server 2008 or higher 

 

 Please note:  

 A license server program needs not necessarily run on a fileserver system or on a special hardware 
server; suitable will be any computer fulfilling the above-mentioned requirements. 

 The license server must not be installed on the same computer as the ISD product (e.g. HiCAD/HELiOS) 
as both programs share system information regarding the licensing.  

 An internet access is needed on the computer/server on which the licenses are managed.  

 

2.7.1 Network licenses on virtual machines (VM) 
If you want to use/activate/deactivate the network licenses on virtual machines, please observe the following 
points:  

» A static MAC address is required  

» A static IP address is recommended or required when using Commuter Licenses  

» Before copying or changing a virtual machine, deactivate the network licenses, since the UUID 
(Universal Unique IDentifier) of the VM will change due to the copying process, and cannot be 
deactivated afterwards any more. This also applies to the starting of the VM on a different host. 

 



System Requirements 

23 

2.8 Hardware Requirements HELiOS Smart Search Server 
See Hardware Requirements HELiOS Vault Server 
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2.9 Hardware Requirements HELiOS Application Server 
Please contact our consulting team for further information concerning hardware requirements and 
installation of HELiOS Application Server. 
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2.10 Further Installation Requirements 
» Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed on the computer 

before HiCAD/HELiOS can be used; these packages will be installed as part of the HiCAD installation if 
required.  

» The graphics card must support Open GL 2.0 or higher. If the hardware or driver does not support this 
standard, there will be shown a warning message when installing HiCAD and a compatibility mode will 
be used (with low graphic performance). 

» To be able to work with HELiOS, a database system must be available that has been prepared for 
HELiOS. For this you require 

 A Microsoft SQL Database Management system on your Server, 

 A HELiOS database imported with the HELiOS Database Creator and  

 An ODBC connection on the Clients. 

Documents (in .pdf format) describing the installation procedure for the database system and the import 
and export of the database can be found in the Wiki at Product Know-how > Documentation > HELiOS.  

Current information on system requirements can also be found on the Internet at https://www.isdgroup.com 
at Support > ISD Wiki > Product know-how > FAQ. 

 

https://wiki.isdgroup.com/display/Heliosdoc/HELiOS+Documentation
https://wiki.isdgroup.com/display/FAQ/FAQ+-+Frequently+asked+questions
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3 Installation 
The DVD contains the installation files for:  

» HiCAD 

» HELiOS Desktop (Standalone) 

» The Online Help  

» The HELiOS Vault Server 

» The HELiOS SmartSearch Server 

» The HiCAD Spooler 

» The HELiOS Spooler  

» HiCAD Viewer 

» The License Server  

» The PostScript printer driver (required for the output of several views to a PDF file) 

» The HELiOS Database creator (to set up the HELiOS database for the very first time and import/export 
an existing database) 

The DVD has been developed for Windows operating systems. When you insert the DVD, an installation 
wizard will be started automatically. 

 

 The HiCAD and HELiOS version must be installed on the hard disk of the computer; it is not possible to start 
the programs from the DVD. 

 

If the Autostart function has been deactivated in the operating system, it is mandatory for the installation of 
HiCAD to start the setup.exe file from the root directory of the DVD; only in this way it is ensured that the 
version will recognize the operating system, and that the matching HiCAD version will be installed.   

 

In the installation wizard, click the Standard Edition button, which opens a mask with various selection 
options for software components.   
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Leave this selection mask open, so that you can select the desired components one after the other.  
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3.1 Installing HiCAD 

 

Click the HiCAD and HELiOS button to start the installation.  

Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to be installed on the 
computer before HiCAD/HELiOS can be used; these packages will be installed as part of the HiCAD 
installation if required.  

 

 

 

First, important information about data compatibility will be displayed. Please read this information carefully. 
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Specify an installation directory.  

 

You can help us increase the user-friendliness of our products even further. To participate or terminate your 
participation, please activate the corresponding checkbox. 

You can terminate your participation at any time by choosing Help > Customer Feedback, and selecting the 
corresponding checkbox.  

In the dialogue window, the data protection notice for collection of data for constant GUI optimization can be 
opened.  

 

Data Protection notice: Collection of Data for Constant GUI Optimisation  

You can help us increase the user-friendliness of our products even further. If you participate, the ISD will 
collect information on your use of our software, in order to detect trends and use patterns.  This information 
will then be used for a constant optimisation of our user interface, with the aim to make the operation of our 
software as convenient and efficient as possible for our users. 

The collected information  

 Contains data on the functions that you used (frequency and chronological order). 

 Contains a key enabling the identification of your computer. It does not contain any personal data, and 
will not be used to detect your identity. The key will only be used to obtain data on the diffusion rate of 
customer feedback. For instance, it is important to know whether a functionality has been used 100 
times by 1 customer, or whether another function has been used only once by 100 customers etc. 

 Will be automatically removed after transmission to the ISD.  In case of a failed transmission (e.g. 
because of network problems) the information will be automatically removed after 1 week at the latest 
when the program has been re-launched. 

https://help.isdgroup.com/helpdirect/1033/isd_feedback.pdf
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 Will not cause a slowing down of the program operation. 

ISD will not  

 Store your name, address, or any other personal data. 

 Ask any further questions besides asking for your consent to the participation. 

 Use the data for any other purposes than those described above. 

 Contact you in any form in connection with your participation. 

You can choose to participate when installing the product for the first time. To terminate your participation at 
a later time, choose Help > Customer Feedback, and select the corresponding option.  

 

 

 

Please read the Notes on Hardware exchange carefully. 

 

Notes on Hardware Exchange 

If you use local HiCAD/HELiOS licenses and want to exchange any hardware components, modify the 
partitioning of, or re-install the operating system, you need to revoke the existing license on the HiCAD 
workstation first, and request, using the new hardware or modified configuration, a new license key (further 
information on the procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs 
in an appropriate amount for the reissuing of the license. If the license will not be revoked, or if such 
revocation is no longer technically possible, the ISD may request proof that the unrevoked license is no 
longer utilisable; in case of failure to produce such proof, the ISD reserves the right to refuse the transfer of 
the license to a new hardware.  

 

Accept the notes and click Next. 
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For different drawing areas HiCAD offers especially adjusted surfaces and configurations, e.g. for 
Mechanical Engineering, Steel Engineering and Plant Engineering. These can be selected during the 
installation of HiCAD.  

Depending on the parameter configuration the saved settings in the CSV file will be applied, too. The CSV 
file contains information on e.g. which files (e.g. HiCAD part masks or template files for labels) should be 
copied into the sys directory. In case of an update different system files in the HiCAD sys directory will be 
replaced – without further inquiry – by file supplied in the HiCAD templates directory, which are specifically 
adjusted to the chosen modules and activated checkboxes (e.g. DSTV or Management + BIM).   

Via Extended Settings you can change the parameter configuration once more and select your own template 
files. 

Select a module for the parameter configuration and click Next. 

 

 

You can now start with the installation or modify the Extended Settings, e.g. for the user configuration, the 
catalogues, or HiCAD with HELiOS.  
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In the Configuration Database, customer-specific settings for various features such as dimensioning, 
annotations, workshop drawing creation or fitting of vertical ladders are stored. When performing an update, 
customer-specific settings can be applied. In addition, values that have not been modified by the user will 
automatically obtain the updated pre-settings.  

In the Parameter configuration you can modify previously activated default templates. Moreover, you can 
select CSV files via Own templates. The settings stored in the CSV file, too, will be applied. In a CSV file it is, 
amongst other things, specified which files (e.g. HiCAD part masks or template masks for annotations) are to 
be copied to the sys directory. When performing an Update, various system files in the HiCAD sys directory 
will be replaced with the files supplied in the HiCAD templates directory which have been designed 
especially for a working with the selected module and the activated checkboxes (e.g. …DSTV or 
Management + BIM). The standard CSV files are located in the templates directory of the HiCAD installation. 
CSV files are configuration templates that you can create and edit with Microsoft Excel (please see Online 
Help). 

Parameter configuration: No templates is activated by default in Parameter Configuration. You can also 
change this setting subsequently, via the programs ..exe/ParKonfigComp.exe (for the workstation) and 
..exe/ParKonfigUser.exe (for the User). 

 

The execution of the CatalogueMaker serves the purpose of specifying which standard series are to appear 
in the standard part catalogues (currently standard series are available for DIN, ISO, EN, ANSI and JIS); the 
selection of standards in the CatalogueMaker only influences the display of standard parts, but not their 
availability; the availability is still controlled via license selection in the ISD License Manager.    

In case of updates, the existing configuration will be applied, and the CatalogueMaker will not be started 
automatically. If you want to add standards to the catalogues, the program can be called via Start > All 
Programs > ISD Software und Systeme GmbH > Administration.  
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In case of a new installation of HELiOS you can specify an arbitrary name for the system data source. In 
case of an update, the existing data source will be offered. User and Password will be identical with the 
ODBC login.  

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address 
input field, and the Server Port of the Vault Server in the Port input field. You already entered both during 
the installation of the Vault Server.  

If you have not installed the Vault Server yet, you can do this now: Choose HELiOS Options > Database > 

General > Vault Server  .  

During an update installation it will be checked whether the existing HELiOS version is newer than the one 
on the DVD. If this is the case, the HiCAD installation will only update the non-HELiOS files. The HELiOS files 
are those that would be supplied by a standalone installation of the HELiOS Desktop, minus the 
hicadcommons contained therein.  

If you want to process your print jobs via the ISD Plot Management, you need to install one PrintClient on 
each workstation. Activate Use Spooler. In the Server field, enter the network name of the computer on 
which the Spooler is installed. The Spooler collects the print jobs and processes them, taking your settings 
into account.  

Individual settings for the HELiOS surface can be transmitted to additional users and computers. To do so, 
create a ZIP file in HELiOS via View > Settings > Export. During the installation you can select and import 
the surface configurations for the HELiOS desktop under UI configuration.   

 

The availability of interfaces with HELiOS depends on the programs that are installed on your computer. 
With the exception of the HELiOS interface, you can only use 32Bit versions with HELiOS 32Bit, and 64Bit 
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versions only with HELiOS 64Bit. For MS Office it is generally possible to use a 32Bit Office with HELiOS 
(64Bit). However, for old BOMs an additional, special ODBC connection will be required. In such cases, 
please contact our Consulting team.  

Multiple selections are also possible. The HELiOS functions will be integrated in the programs that are linked 
to HELiOS. 

 

 Please note:  

 A compatibility matrix of the CAD systems can be found in the Wiki, at Product Know-how > FAQ > 
System & Hardware > HELiOS Desktop. 

 Integration of shared networks 
If a directory is accessed by more than one computer, in the filegrup.dat under C: (for the Scenes 
directory) should not be listed a local path or the network connection letter, but the entire UNC path 
according to the pattern 
C:\\servername\ShareName\Directory  

The filegrup.dat can be found in the HiCAD/HELiOS installation in the HiCAD exe directory and in case of 
an EPlan interface as well under HELiOS EPlan SyncService\exe. In the HELiOS Standalone installation 
the filegrup.dat can be found in the HELiOS exe directory.  

 

If you have installed LogiKal on your computer, you can enter the installation directory here. 

 

https://wiki.isdgroup.com/display/FAQ/HELiOS+Desktop
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The Activate license administration tools must be activated for the installation of server licenses.  

If you checkmark the Activate ISD Update Service option, a Hotfix will be searched on the ISD Web Server 
when you start HiCAD.  You can also activate this option subsequently via the Windows Control Panel: 
There, choose Programs and Features, right-click on HiCAD and choose Change. 

Click Save to save the Extended Settings to an INI file. If you place the INI file in the installation directory 
when installing server licenses, the settings will be applied.  

As soon as you exit the Extended Settings dialogue with OK, the installation will be started. 

 

 In HiCAD, at Settings > Further directories you can set the paths for the database of the Configuration 
Editor, the Catalogue directory and LogiKal. These paths are located in the Windows Registry at 
HKEY_LOCAL_MACHINE\SOFTWARE\ISD Software und Systeme\HiCAD\nnnn.n.  
nnnn.n is the HiCAD version number, e.g. 2400.0. 

 

 

Click Finish to complete your HiCAD installation. If desired, you can use the buttons of the installation mask 
to install further software components.  



Installation 

 36 

3.2 Installing HELiOS Desktop (Standalone) 
The HELiOS Desktop is normally installed automatically when you install HiCAD. Of course, you can also 
install HELiOS separately. To do this, start Windows. If Windows is already open, close all other applications. 
Insert the HELiOS DVD in your DVD drive. The installation wizard will be started automatically. Follow the 
instructions on the screen.  

 

In the installation wizard, click the Standard Edition button, which opens a mask with various selection 
options for software components. Please leave this selection mask open, so that you can, one after the 
other, install the desired components.  

 

Click the HELiOS button. 

 

 

Select an installation directory. 
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In accordance with the current Microsoft guidelines, the HELiOS documents will be saved to 
C:\Users\Public\Documents\ISD Software und Systeme\ in case of a new installation. Only the Administrator 
has write permissions for the installation directory (C:\ProgramFiles\..).   

If you work on several workstations without a Vault Server, you need to enter on each workstation the path of 
the document directory into the system file FILEGRUP.DAT. This means that the default path needs to be 
changed accordingly in all corresponding places of the FILEGRUP.DAT. The directory should be a shared 
network directory to which all Clients have access. 

 

Please read the Notes on Hardware Exchange carefully. 

 

Notes on Hardware Exchange 

If you use local HiCAD/HELiOS licenses and want to exchange any hardware components, modify the 
partitioning of, or re-install the operating system, you need to revoke the existing license on the HiCAD 
workstation first, and request, using the new hardware or modified configuration, a new license key (further 
information on the procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs 
in an appropriate amount for the reissuing of the license. If the license will not be revoked, or if such 
revocation is no longer technically possible, the ISD may request proof that the unrevoked license is no 
longer utilisable; in case of failure to produce such proof, the ISD reserves the right to refuse the transfer of 
the license to a new hardware. 

 

Accept the notes to continue with the installation. 

 

You can now start with the installation or modify the Extended Settings, e.g. for HELiOS. 
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In case of a new installation you can specify an arbitrary name for the system data source. In case of an 
update, the existing data source will be offered. User and Password will be identical with the ODBC login.  

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address 
input field, and the Server Port of the Vault Server in the Port input field. You already entered both during 
the installation of the Vault Server.  

If you have not installed the Vault Server yet, you can do this now: Choose HELiOS Options > Database > 
General > Vault Server  .  

If you want to process your print jobs via the Plotmanagement of the ISD, you need to install a Print Client 
on each workstation. Activate Use Spooler. In the Server field, enter the name of the computer on which you 
install the Spooler. The Spooler collects the print jobs and processes them according to your settings.   

Individual settings for the HELiOS surface can be transmitted to additional users and computers. To do so 
create a ZIP file in HELiOS via View > Settings > Export. During the installation you can select and import 
the surface configurations for the HELiOS desktop under UI configuration.   

 

The availability of interfaces with HELiOS depends on the programs that are installed on your computer. 
With the exception of the HELiOS interface, you can only use 32Bit versions with HELiOS 32Bit, and 64Bit 
versions only with HELiOS 64Bit. For MS Office it is generally possible to use a 32Bit Office with HELiOS 
(64Bit). However, for old BOMs an additional, special ODBC connection will be required. In such cases, 
please contact our Consulting team.  

Multiple selections are also possible. The HELiOS functions will be integrated in the programs that are linked 
to HELiOS.  
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 Please note:  

A compatibility matrix of the CAD systems can be found in the Wiki, at Product Know-how > FAQ > System & 
Hardware > HELiOS Desktop.  

 

 

You require the License Administration Tools for the installation of server licenses.  

Click Save to save the Extended Settings to an INI file. If you place the INI file in the installation directory 
when installing server licenses, the settings will be applied.  

Close the Extended Settings dialogue with OK and start the installation. 

 

https://wiki.isdgroup.com/display/FAQ/HELiOS+Desktop
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After successful installation, you will find the HELiOS shortcut on the Desktop for program launch.  
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3.3 Installing Online Help  
The Online Help is available locally (status of the date of installation DVD creation) and on the Internet 
(regularly updated) at www.help.isdgroup.com. Both versions of the Help can be directly launched from 
HiCAD. Please note that corresponding login data are required to access the Internet version of the Help.  

Start Windows to install the Help. If Windows is already open, close all other applications. Insert the DVD in 
the drive, which automatically starts the installation wizard. In the installation wizard, click the Standard 
Edition button, which opens a mask with various selection options for software components. Please leave 
this selection mask open, so that you can, one after the other, install the desired components. 

 

Click the HiCAD and HELiOS Help button. 

 

Specify the installation directory for HiCAD/HELiOS and click Next. 

 

Click Next.  

http://www.help.isdgroup.com/
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Click Install to start the installation.  

 

After successful installation, the Help can be found in the program folder and can be called via 
HiCAD/HELiOS.  
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3.4 Installing HELiOS Vault Server  
Start Windows to install the Vault Server. If Windows is already open, close all other applications. Insert the 
DVD in the DVD drive, which automatically starts the installation wizard. In the installation wizard, click the 
Standard Edition button, which opens a mask with various selection options for software components. 
Please leave this selection mask open, so that you can, one after the other, install the desired components. 

 In rare cases an older, manually installed version of the VaultServer might be found, which will not be 
modified (updated) as a precaution. If an error message appears, please contact our colleagues from the 
Hotline. E-Mail: helpdesk@isdgroup.de 

 

Click the HELiOS Vault Server button. 

 

 

Specify the installation directory of the Vault Server. 

mailto:helpdesk@isdgroup.de
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Give the Vault Server a name, e.g. the name of your company, plus the location of your company. This name 
will be shown, for example, when you connect to the Vault Server from the Vault Client.  

 

The Vault Server renames all documents that are managed in the database (e.g. SZA, DOC, XLS, …) to 
*.VDF. These VDF files are saved to the Document directory.  

The files stored in the Management directory contain the assignments of the VDF file names to the “original 
file names”.   

Log files (*.LOG) are saved to the Log directory. They record each access to the VDF files. 

Enter the name of the log file in the Log file name field. The name of the Vault Server would also be possible 
here. If the log file exceeds a certain length, it will be cut down and suffixed by the current date. 
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Click the Install button.  

 

Click Finish to complete the installation of the Vault Server. You can now install further components offered 
in the selection mask if desired. 
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3.5 Installing HiCAD Spooler  
HiCAD Spooler runs on a separate Plot Server System. Start Windows to install the HiCAD Spooler. If 
Windows is already open, close all other applications. Insert the DVD in the DVD drive, which automatically 
starts the installation wizard. In the installation wizard, click the Standard Edition button, which opens a 
mask with various selection options for software components.  

 

Click the HiCAD Spooler button. 

 

 

First, important information is being displayed with regards to File and database compability. Please read 
carefully.  
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Specify the installation directory for the software. 

 

Please read the Notes on Hardware Exchange carefully. Accept the Notes on License Management in order 
to proceed.  

 

You can now either begin with the installation or open the Extended Settings, for example to modify the user 
configuration or catalogues.  

Begin the installation. 
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After successful installation, the HiCAD Spooler will be located in the program folder.  
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3.6 Installing HELiOS Spooler 
 

Important note on installation! 

As the HELiOS Spooler (as of HELiOS 2015, V 2000.0) is an entirely new software, an update of the old 
Spooler is not possible. Before installing the new HELiOS Spooler, please make a record of the old Spooler’s 
settings, uninstall it, and then adjust the settings of the new Spooler accordingly. 

Further information can be found in the HELiOS Online Help. 

The HELiOS Spooler is only available as a 64Bit version, and supports only 64Bit applications.  

 

To install the HELiOS Spooler, please start Windows. If Windows has already been started, please close all 
other applications. Insert the DVD in your DVD drive. The selection mask for various software components 
will then be displayed. Leave this mask open, and install one after the other, the required software 
components.  

 

Click the HELiOS Spooler button.  
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Specify the installation directory for the software. 

 

In the Service registration area you can choose between the options Local system and User account. 

A part of the Spooler is started by the system as a background process (Windows service). For safety 
reasons it is recommended to create a Windows User account, with User name and Password with read 
and access permission, before installation.  

If you do not know the user yet, you can choose Local system. The Spooler will then run, initially without 
access to any printers, as a simple Windows system service. Now, select Control Panel > Administrative 
Tools > Services. Right-click the HELiOS Spooler and select Properties. On the Log On tab, switch to This 
account and enter the user name and the password (Caution: Should the password of the Spooler user 
change or expire one day, the authentication needs to be renewed accordingly in the Services list). If the 
Start service upon installation option is active, the Spooler service will not require a manual start after 
installation.  

For starting the “interactive” configuration of the Spooler automatically, the file Helios.Spooler.exe from the 
installation directory must be invoked with the option “—no service”, for instance, either from the 
“Autostart” folder or via Windows task planning. If you have further questions, please contact our ISD 
Consulting team.  

Select the data directory. Activate the Create network share checkbox to enable the communication with the 
PrintClient. If the network share is not created during installation, it must be created manually afterwards. 
Since special settings will be required here, we recommend contacting our Consulting team. 

Choose the CAD system that you want to link to the HELiOS Spooler, and click Next.  
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You can now begin with the installation. 

 

After successful installation the HELiOS Spooler will be located in the program folder. 
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3.7 Installing HiCAD Viewer 
The HiCAD Viewer enables you to view drawings in HiCAD format (*.sza, *.szx) and output these drawings 
(in non-scale representation). This viewer is free of charge and may be provided free, without changing the 
scope of delivery.  

 

Activate the HiCAD Viewer. 

 

 

Specify the installation directory for the software. 
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You can now begin with the installation. 

 

Click Finish to end the HiCAD Viewer installation. You can now choose more components from the selection 
mask. 
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3.8 Installing HELiOS Database Creator 
The HELiOS PDM modules (Document management, Part Management, Workflow etc.) are based on a 
relational database. Before you put HELiOS into operation, the Microsoft SQL Server database administration 
system needs to be installed on the server, a HELiOS database needs to be imported and a ODBC 
connection needs to be set up on the clients.  

When you set up a HELiOS database for the first time, the HELiOS Database Creator needs to be installed 
and executed on the database server first. The database and table structures will then be created, and filled 
with data records of the HELiOS standard database. 

 

 Further information about the correct procedure for the execution of the HELiOS Database Creator, as well 
as the previous and subsequent steps required for the setting up of a database server can be found in the user 
guide for the installation of the Microsoft SQL Server. You can find this document in the ISD Wiki at Product 
Know-how > Documentation > HELiOS. 

 

To install the HELiOS Database Creator, click the corresponding button in the selection mask. The start 
mask of the setup wizard will be displayed.  

 

 

Click Next to start the installation. 

https://wiki.isdgroup.com/display/DOC/Documentation


Installation 

55 

 

Specify an installation directory for the HELiOS Database Creator and click Next.  

 

Click Install to start the installation.  

 

Click Finish to complete the installation of the HELiOS Database Creator. If desired, you can now install 
further components via the selection mask. 
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3.9 Installing HELiOS SmartSearch Server 
The Smart Search in HELiOS allows finding documents, assemblies, folders and projects on the basis of an 
overarching (including all object types) metadata and full text search.  

For using Smart Search, an index server of HELiOS Smart Search Server must be installed. The only 
requirement for the installation is JavaRuntime Environment. If Java Runtime Environment is not available 
on the server yet, it must be installed, too.  

 

 The SmartSearch functions have to be activated by a registry entry per each workplace. For this, the 
provided file EnableSmartSearch.reg from the installation directory HELiOS SmartSearch can be executed 
on the respective computer. 

 

To install the HELiOS Smart Search Server, start Windows. If Windows is already open, exit all running 
programs. Insert the DVD-ROM into the DVD-ROM drive of your computer. The screen with the software 
components opens subsequently. The selection screen stays open, for that the necessary components can 
be installed successively.  

If the Autostart Function is shut down in the operating system, it is necessary to run the file setup.exe from 
the main directory of the DVD-ROM, as only then it is ensured that the version identifies the operating 
system properly and the appropriate version will be installed. 

 

Activate HELiOS SmartSearch Server. 

In case if there is no Java Runtime Environment available yet, it must be installed first. 

 

Click Next. 
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Select an installation directory of the HELiOS SmartSearch server and click Next. 

 

You can start the installation now. 

 

Click Finish to end the installation. 
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3.10 Trial Edition (Demo Version) 
The Trial Edition (Demo Version) has a changed data format, which allows a reading of data out of the 
Standard Edition, but not a writing of data back to it (i.e. in a Standard Edition the data format of special 
versions is not readable!). For printouts, plot stamps will always be output.  

 

 The license is free and valid for 30 days from the date of installation. Its transfer to other computers after 
its activation is not possible.    

 

If the Autostart function has been switched off in the operating system, you must run the setup.exe file in 
the root directory of the DVD for installation. Only in this way will be be ensured that the version of the 
operating system will be correctly recognized and that the correct HiCAD version will be installed.  

 

In the start mask of the Installation Wizard, click Trial Edition.  

Before using HiCAD/HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have 
been installed on the computer; these packages will be installed as part of the HiCAD installation if required.  

 

On the Welcome... window, click Next to start the installation.  
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Enter the activation data for product activation and click Next. 

To obtain the activation data, please fill in the form on our website at isdgroup.com > Products > Free 
demo version. 

 

Select an installation directory.   

 

Click Install.  
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Click OK to complete the installation. 
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3.11 Education Edition (Student Version)  
The Education Edition (Student Version) is a fully functional standard version. The license is free and valid 
for 1 year (365 days). It can be activated and deactivated with the ISD License Manager, which will be 
available after installation (see Chapter 7.3). 

The drawings (.-SZA) and parts (.KRA) created with Education Edition can not be loaded with the Standard 
Edition. In case if a file (.SZA or .KRA) created with the Education edition is opened with a Standard Edition, 
an appropriate message will be sent. The title bar of the HiCAD interface will show the text HiCAD Education 
Edition: Not for commercial purposes.  

If the Autostart function has been switched off in the operating system, you must run the setup.exe file in 
the root directory of the DVD for installation. Only in this way will be ensured that the version of the operating 
system will be correctly recognized and that the correct HiCAD version will be installed. 

 

In the start mask of the Installation Wizard, click Education Edition.  

Before using HiCAD/HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have 
been installed on the computer; these packages will be installed as part of the HiCAD installation if required. 

 

On the Welcome... window, click Next to start the installation. 
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Enter the activation data for product activation and click Next. 

To obtain the activation data, please fill in the form on our website at isdgroup.com > Products > Student 
version and upload your student identity card or your matriculation certificate. 

 

Select an installation directory.  

 

Click Install.  

https://www.isdgroup.com/de/isd-produkte/kostenlose-cad-studentenversion.html
https://www.isdgroup.com/de/isd-produkte/kostenlose-cad-studentenversion.html
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Click OK to complete the installation.  
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4 Procedure for Silent Installations 
The silent installation can, for example, be configured for HiCAD, for HELiOS Standalone or for the HiCAD 
Spooler. The procedure is always the same. 

 

4.1 Installation Settings 
To configure the installation options, start the installation setup.exe as usual and make the required settings. 

In the last dialogue of the installation, click on Extended Settings. 

 

Here you can configure in particular the settings for the User Configuration and the Catalogs in such a way 
that user interactions will no longer be required. 

» Parameter configuration via CSV file,  

» Execute CatalogueMaker/CatalogueUpdate: Deactivate Interactive button. 
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Clicking Save creates a setup.ini file containing the desired settings. This file will be loaded automatically if it 
is located in the same directory as the Windows Installer package HiCAD.msi. Alternatively you can specify a 
file via the command line:  

setup.exe  SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

or 

msiexec  /i  HiCAD.msi SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

In this case the starting will not be “silent”, i.e. the installation dialogues will appear, but with the default 
values of the .ini file. 

The option /l*v "<Log-Datei>" creates a log file of the installation which can be used for the diagnosis of 
installation problems.  

 

4.1.1 Redistributables 
Before distributing the installation you need to install the required redistributables on the target systems in 
order to circumvent the Microsoft-EULAs.  

Examples:  

vcredist.exe /passive 

dotNetFx40_Full_x86_x64.exe /passive 

The respective command line options of the individual Redistributable Installer can be called via the 
command line option /?.  

If required, the .msu files of the Windows Installer 4.5 can be installed with the Windows Package Manager 
pkgmgr.exe (http://support.microsoft.com/kb/934307/de). 

The packages can be installed with /passive /norestart. Otherwise, a reboot would be initiated automatically. 
If a package requires a reboot, the return value is 3010; otherwise it is 0 or an error code.  

 

 You need to install the redistributables that are located on the DVD at Program32 or Program64 (except 
for the setup.exe and the language-specific folders such as de-de). 

The situation for HELiOS is slightly different. Here, the installation packages can be found in the folder 
Helios\heldsk64\ (for a HELiOS Desktop Standalone installation) or Helios\M-Versions\24??\ , with ?? standing for 
the concrete year date of the HiCAD Version to be matched with an updated HELiOS. 

http://support.microsoft.com/kb/934307/de
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The utilisation of the msi package or the setup.exe, respectively, differs insofar as the setup.exe will issue an 
interactive message if a requirement (redistributable) is missing, while the msi package will cancel the process 
with an error code. The latter might be more suitable for a deployment within the scope of a software 
distribution programme. 

 

4.1.2 Starting the Installation in the Silent Mode 
The installation can only be set to the silent mode via the command line: 

setup.exe  SETTINGS="<Ini-Datei>" /passive /l*v "<Log-Datei>" 

or 

msiexec.exe  /i HiCAD.msi /qb!- /SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

As neither dialogues nor error messages are displayed, /l*v "<Log-Datei>" creates a log file of the installation 
which can be used for the diagnosis of installation problems. 

Information on further command line options can be obtained via the command line, by means of the 
command msiexec /? , and via the Internet at 

http://technet.microsoft.com/de-de/library/ cc759262%28WS.10%29.aspx#BKMK_SetUI 

http://msdn.microsoft.com/en-us/library/windows/desktop/ aa372024%28v=vs.85%29.aspx 

 

4.1.3 Example of a Batch Installation incl. Redistributables and Log 
@set SOURCE=\\entw042\Setups\HiCAD 2400 

 

"%SOURCE%\vcredist_x86_10.0.40219\vcredist_x86.exe" /passive /norestart 

@if errorlevel 1 echo Fehler bei Visual C++ Runtime Installation && goto error 

"%SOURCE%\DotNetFX40\dotNetFx40_Full_x86_x64.exe" /passive /norestart 

@if errorlevel 1 echo Fehler bei .NET Installation && goto error 

 

msiexec.exe /qb!- /i "%SOURCE%\de-de\HiCAD.msi" /l*v 
"%SOURCE%\logs\%COMPUTERNAME%_HiCADInstallLog.txt" SETTINGS="%SOURCE%\Config\setup.ini" 

@if errorlevel 1 echo Fehler bei HiCAD Installation && goto error 

@exit 

 

:error 

@echo Installationsfehler %errorlevel% 

@net helpmsg %errorlevel% 

@pause 

http://technet.microsoft.com/de-de/library/%20cc759262%28WS.10%29.aspx#BKMK_SetUI
http://msdn.microsoft.com/en-us/library/windows/desktop/%20aa372024%28v=vs.85%29.aspx
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5 Configuration 
5.1 Configuration Management 
As of HiCAD 2012 (Version 1700), HiCAD enables a central configuration management with the 
Configuration Editor. This tool allows the creation of customer-specific configurations for a wide range of 
tasks, such as dimensioning, annotation, workshop drawing creation, fitting of vertical ladders etc. Once 
adjusted to company-specific requirements, these configurations can directly be used in HiCAD, without 
having to specify any further settings. The aim of our further developments is a gradual transfer of the 
previously used system files with their adjustable parameter settings into the Configuration Editor, thus 
enabling a central and safe configuration management. 

This transfer has already been realised for the following files:  

» ALGPAR.DAT (as of 1800.0) 

» BEMPAR.DAT (as of 1800.0) 

» DIMENSIONING_SETTINGS.XML (as of 1800.0) 

» KRPGEN.DAT (as of 1801.0) 

» MASPAR.DAT (ab 1801.0) 

» FITTABLE_SETTINGS.XML (as of 1801.0) 

» STBEMPAR.DAT (as of 1801.0) 

» TXTANSI.DAT (as of 1801.0) 

» STABMPAR.DAT (as of 1802.0)  

» AUBM3PAR.DAT (as of 1802.0) 

» ALG3DPAR.DAT (as of 1901.0) 

» FEATURE.DAT (as of 1901.0) 

» SCHRIF.DAT (as of 1901.0) 

» TXTFONT.DAT (as of 1901.0) 

» LINPAR.DAT (as of 1901.0) 

» SSWRITESTEP.DAT (as of 1901.0) 

» PASSTAB.DAT (as of 2000) 

» ANSGEN.DAT (as of 2100) 

» PARAMASS.DAT (as of 2101) 

» SSTINI3D.DAT (as of 2102) 

» SSTINI.DAT (as of 2102)  

» STB_PARAMETER.DAT (as of 2102) 

» GRAPAR.DAT (as of 2201) 

» KNTPAR.DAT (as of 2202) 

» REF3D ATTR AKT.DAT (as of 2300) 
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» TXTPAR.DAT (as of 2300) 

» TABPAR.DAT (as of 2400)  

» ABWPAR.DAT (as of 2402)  

» ABWCOL.DAT (as of 2402) 

The settings from these files have been integrated into the Configuration Management. In the Online Help 
for the Configuration Management you will find the document Schluesselnamen.pdf, which shows you 
where you can retrieve the entries from the DAT files in the Configuration Editor.  

In addition, the Online Help provides a description of various scenarios for the utilisation of the tool.  An 
extensive description of the Configuration Management (Performance – Functions – Scenarios) is provided 
in the document ISD-Configuration.pdf. You can find this document 

» in the ISD Wiki at Product Know-how > Whitepaper 

» in the Docu\hicad sub-directory of your HiCAD installation as well as 

» on the start page of the Online Help at https://help.isdgroup.com/en/. 

 

5.1.1 The Configuration Management for updates 
When performing an update from HiCAD 2017 or HiCAD 2018, your settings from the existing configuration 
file HICAD.CFGDB of your previous HiCAD version will be transferred to the Configuration Management of 
HiCAD 2019, namely into the Administrator profile. 

When the update is performed, only the values predefined by the ISD, i.e. the “factory settings”, will be 
changed. All other (administrator or user) settings will be preserved.  

If you use a central configuration database on a server, it will be automatically detected by the update 
program by means of the aforementioned Registry entry, and will be updated. For an update of several 
workstations, one single update will be sufficient; a multiple update will, however, not do any harm either (as 
an already updated setting will not be updated again).  

When HiCAD is started, the configuration database will be checked.  

If HiCAD is started with an outdated configuration base, a corresponding message will be displayed. In this 
case, please perform an update of the configuration database in order to avoid error messages or 
unexpected behaviour.  

If HiCAD is started with the database of a newer Major Release, a corresponding message will be displayed. 
In this case, please use a compatible database to avoid error messages or unexpected behaviour. 

 

5.1.2 The Configuration Management for new installations  
If you perform a (new) installation of HiCAD 2019, the settings predefined by the ISD will be initially used in 
the Administrator profile of the Configuration Management. If you want to transfer your individual settings in 
the file HICAD.CFGDB from HiCAD 2017 or HiCAD 2018 to the Configuration Management of HiCAD 2019, 
use the program CfgDbTool.exe in the HiCAD EXE sub-directory for this. 

Furthermore, you are enabled to transfer settings from old DAT and XML files which are now managed in 
the Configuration Editor, to the configuration database of the current version. 

https://help.isdgroup.com/help/1033/2019/hicad/schluesselname.pdf
https://help.isdgroup.com/help/1033/2019/hicad/isd-configuration.pdf
https://help.isdgroup.com/en/
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Start the CfgDbTool.exe from the HiCAD / exe sub-directory.  

 

Use the Update tab of the CfgDBTool you tab to transfer the settings of your previous configuration file 
(.CFDB) to the configuration file.  

 

Installed database The configuration database to be updated, i.e. (the configuration database of 
your previous HiCAD. 

Update source The configuration database of the new version; the configuration database with 
the current ISD settings can be found in the folder: [HiCAD installation 
directory]\Configuration.  

Update target The result of the update. If you enter the same file here as in the Installed 
database, a backup of the previous configuration database will be created. 
You cannot enter the same database here that you entered in the Update 
source field. 

 

» Select the directories. 

» Click the Update button to start the process. 

Use the Migrate tab to transfer your individual settings from old DAT and XML files which are now managed 
in the Configuration Editor, to the configuration database of HiCAD 2019. 

The setting files with their adjustments need to be copied to the HiCAD SYS subdirectory of the new HiCAD 
version for this purpose.  

Start the CfgDbTool.exe  from the HiCAD / exe sub-directory and activate the Migrate tab.  
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HiCAD base folder Here you enter the directory where your old DAT and XML files etc. are located. 
Please make sure that the old files have the same name and are located in the 
same directory structure as in a HiCAD standard installation. 

Target database Here you specify the database to which the data are to be transferred. 

 

» Select the directories. 

» Click the Migrate button to start the process. 
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5.2 Parameter Configuration 
 

Important note on updates!  

When you run the tool Computer Parameter Configurator (HiCAD exe\ParKonfigComp.exe) – either during 
the installation/update (Extended Settings > User Configuration tab) or later – the following message will be 
displayed: 

 

If you confirm with OK, various system files in the HiCAD sys and szenen directory will be replaced with the 
files supplied in the HiCAD templates directory which have been designed especially for a working with the 
selected module and the activated checkboxes (e.g. …DSTV or Management + BIM). These files include, 
for example  

 - HiCAD masks for the part attributes (*.HDX), 

 - HELiOS masks for projects, documents and articles (*.MSK), 

 - Various configuration files (*.HDB) and  

 - Template files for annotations (*.FTD). 

You should therefore always make backups of all files that you have customized before using the 
ParKonfigComp.exe tool! If you have any questions, please contact your nearest ISD branch office. 

Via Cancel the operation will be terminated without any changes to the configuration.  

 

HiCAD provides suitably customised interfaces and configurations for various fields of engineering, e.g. for 
Mechanical Engineering, Steel Engineering, Metal Engineering or Plant Engineering. You can select these 
options during the installation of HiCAD. 

To change the parameter configuration subsequently, start the programs 

» ..exe/ParKonfigComp.exe for the workstation configuration, and 

» ..exe/ParKonfigUser.exe for the user configuration. 

 

Depending on the selection in the Parameter configuration, the settings stored in the CSV file, too, will be 
applied. In a CSV file it is, amongst other things, specified which files (e.g. HiCAD part masks or template 
masks for annotations) are to be copied to the sys directory. When performing an Update, various system 
files in the HiCAD sys directory will be replaced with the files supplied in the HiCAD templates directory 
which have been designed especially for a working with the selected module and the activated checkboxes 
(e.g. …DSTV or Management + BIM). The standard CSV files are located in the templates directory of the 
HiCAD installation. CSV files are configuration templates that you can create and edit with Microsoft Excel 
(please see Online Help). 
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In the dialogue window you have the following setting options:  

» Module 
Here you choose the required filed of engineering. The common HiCAD parameters are then configured 
for this area. 

» Management + BIM   
Provides the BIM-PDM configuration with typical civil engineering attributes, masks and title blocks.   

» Font 
Specifies the text font default setting, e.g. for dimensioning, title blocks, view labelling, annotation etc. 

» Attribute configuration according to DSTV  
If you want the HiCAD attribute masks for parts and drawings to obtain the DSTV-relevant attributes, 
please activate the appropriate checkbox. The files BRW_3DTEIL.HDX and BRW_SZENE.HDX in the 
HiCAD SYS directory will be preset for DSTV BOM configuration.  

» HiCAD/HELiOS Default Solution  
Provides you with a preconfigured database solution for a safe and convenient management of product 
data. If you want to use it, activate the checkbox.  

» Novice Configuration  
If you want HiCAD to be preset so that the automatic procedures of the novice configuration apply, 
activate this checkbox.  

» Management + BIM (Steel Engineering Drawing Management)   
Provides the BIM-PDM configuration with the required civil engineering attributes.  

» User-defined template  
Activate this option if you want to use your own configurations. Then select the relevant configuration 
file.  

 

 Important: 

When performing an update, only activate the copying of default templates if no user-specific, customized 
masks and Bills of Materials are used!    
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6 Important Notes on Updates 
Before making an update from HiCAD 2017 or 2018 to HiCAD 2019 you need to deactivate all licenses 
(Server licenses or local licenses). The procedures for Server licenses and local licenses are different.  

Backups of the following files must be made, for cases in which an unexpected interruption of the update 
occurs: Catalogues, HiCAD.cfgdb (Configuration Database) and HELiOS Database (only required if you 
actually use a HELiOS Database).  

You can conveniently download the current HiCAD version in the Download Area in the ISD Wiki. On the 
corresponding DVD you will find, besides the HiCAD installation, further utilities and the HELiOS installation.  
Please note that the HELiOS installation is the last available HELiOS patch containing the same database 
subversion as the HELiOS version that was originally released with the corresponding Major Release.  

 

6.1 Update Server License   
For a Server license the License Server software and the License Management tools may require an update. 
Furthermore, you need to deactivate the licenses for Versions 2017 or 2018 first, and then activate those for 
Version 2019.  

You can start with the installation of HiCAD Version 2019 before or after activation of the new licenses; a 
starting of HiCAD is, however, only possible after activation of the new licenses.  

The current Version of the SafeNet License Server, Sentinel RMS License Manager 8.6.2, can be found on 
the installation DVD of HiCAD 2019. If you have an older version, you need to uninstall this version with the 
help of the Windows Control Panel. First, uninstall the Sentinel RMS License Manager there and (if there 
are any) the AdminToolsServer.  

You can then install the new version of the License Server from the HiCAD 2019 Installation DVD.  

Click the SafeNet License Server button. The installation guide can be found at Chapter Fehler! 
Verweisquelle konnte nicht gefunden werden.. 

 

Before you can use the new licenses of HiCAD Version 2019, you need to deactivate the old licenses for 
Version 2017 or 2018 with the help of the License Manager. This tool is located in the Windows start menu 
at All programs > ISD Software und Systeme > Administration. 

After starting the ISD License Managers the License Activator tab will be active. Normally, the EID 
(Entitlement ID) field is still filled in and the fields E-mail and Password are still empty. The activated 
modules of Version 2017/2018 are highlighted (blue). Select the Deactivate button to revoke the activation 
of these modules (see Chapter 7.3.3). 

After confirming the deactivation of your old licenses, the ISD will send you an E-mail with one or several 
EIDs. These are required for the activation of the new licenses. The EID-code and the Password remain 
unchanged and can be used for the login and for the license activation again.  

Follow the instructions given in the E-mail and start the ISD License Manager, which you can find in the 
Windows start menu at ISD Software und Systeme > Administration (C:\Program Files (x86)\ISD Software 
und Systeme\AdminToolsServer\exe) after installing HiCAD.  

On the License Activator tab, enter the Entitlement ID, your E-mail address and your Password and click 
Login. After connecting to the ISD License Server, all your purchased licenses will be shown. Activate the 
licenses with a click on the same-named button (see Chapter 7.3.2).  

After successful activation you can start HiCAD.  

https://wiki.isdgroup.com/display/DOW/Download+Area
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6.2 Update Local Licenses  
Before installing HiCAD 2019 you need to deactivate the local licenses for HiCAD 2017 or 2018 on your 
workstation. After installing HiCAD 2019 you need to activate the new licenses. 

To deactivate the old licenses you use the ISD License Manager which is located in the Windows start menu 
at ISD Software und Systeme > Administration (C:\Program Files (x86)\ISD Soft-ware und 
Systeme\AdminToolsServer\exe). 

On the License Activator tab, click the Deactivate button to revoke the activation of the modules, i.e. to 
deactivate them. After successful deactivation, a corresponding message will be displayed.   

After confirming the deactivation of your old licenses, the ISD will send you an E-mail with one or several 
EIDs. These are required for the activation of the new licenses after installing the new HiCAD version. The 
EID-code and the Password remain unchanged and can be used for the login and for the license activation 
with the ISD License Manager 4.0 again.  

After installing HiCAD, follow the instructions given in the E-mail and start the ISD License Manager, which 
you can find in the Windows start menu at ISD Software und Systeme > Administration (C:\Program Files 
(x86)\ISD Software und Systeme\AdminToolsServer\exe).  

On the License Activator tab, enter the Entitlement ID, your E-mail address (the address to which the E-
mails of the Activation@isdgroup.de were sent) and your Password and click Login. 

After connecting to the ISD License Server, all your purchased licenses will be shown. Use the checkboxes 
to select the modules that you wish to activate and confirm your selection with a click on the Activate button. 
The selected modules will then be activated on your workstation. You can deactivate them again at any time 
to enable their use on a different workstation (see Chapter 7.3). 

After successful activation you can start HiCAD.  
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6.3 Update of HiCAD 
The ISD recommends performing an Update Installation when switching from HiCAD 2017 or 2018 to 
HiCAD 2019 or for the installing of Service Packs and Patches.   

 

Important note on updates!  

When you run the tool Computer Parameter Configurator (HiCAD exe\ParKonfigComp.exe) – either during 
the installation/update (Extended Settings > User Configuration tab) or later – various system files in the 
HiCAD sys directory will be replaced with the files supplied in the HiCAD templates directory which have 
been designed especially for a working with the selected module and the activated checkboxes (e.g. …DSTV 
or Management + BIM). These files include, for example  

 - HiCAD masks for the part attributes (*.HDX), 

 - HELiOS masks for projects, documents and articles (*.MSK), 

 - Various configuration files (*.HDB) and  

 - Template files for annotations (*.FTD). 

You should therefore always make backups of all files that you have customized before using the 
ParKonfigComp.exe tool! If you have any questions, please contact your nearest ISD branch office.  

 

6.3.1 Backups before installation   
Before starting the HiCAD Update Installation, create backups of the following files:   

» Catalogues  

» HiCAD.cfgdb (Configuration Database)  

» HELiOS Database (only required when you actually work with a HELiOS Database)  

These components will be automatically updated during the installation. Nevertheless is a backup of these 
components recommended, e.g. for cases in which an unexpected interruption of the update occurs.   

Please create an archive folder for the storage of these backups.   

 

6.3.1.1 Backups of catalogues  

Search the folder where the catalogues of the old version are located.  

» In case of a local installation this is usually the KATALOGE folder in the directory of your HiCAD 
installation.  

» In case of a network installation the catalogues are normally located in a shared network folder, which is 
indicated in the Windows Registry at HKEY_LOCAL_MACHINE\SOFTWARE\ISD Software und 
Systeme\HiCAD\230X.X (or 240X.X) in the CatDir key. 

In the Windows Explorer, right-click the folder that contains the catalogues. Select Send to > Compressed 
(zipped) folder. Important: Please choose a descriptive name for the zipped folder enabling an easy 
recognition of the catalogues, e.g. HiCAD_2018_CATALOGUES.ZIP  

After its creation, move the file to the archive folder.  
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6.3.1.2 Backup of configuration database HiCAD.cfgdb  

Before installing the new HiCAD version, copy the old file HiCAD.cfgdb to the archive folder.   

In the Windows Registry atHKEY_LOCAL_MACHINE\ SOFTWARE\ISD Software und Systeme\HiCAD\230X.X 
(or 220X.X) in the CfgdbPath key you can see where the file HiCAD.cfgdb is located. 

 

6.3.1.3 Backup of HELiOS database  

1. Open the SQL Server Management Studio. Select Start > All Programs > Microsoft SQL Server 
20XX > SQL Server Management Studio.  

2. Click Connect.  

3. At the left side, right-click bauteil… in the list.  

4. Select Tasks > Back Up.  

5. Ensure that the backup will be stored in the archive folder. You can then compress the backup file 
(.bak) to a ZIP file.   

 

6.3.2 Update Installation of new HiCAD Version 
You can conveniently download the current HiCAD version in the Download Area in the ISD Wiki. On the 
corresponding DVD you will find, besides the HiCAD installation, further utilities and the HELiOS installation.  
Please note that the HELiOS installation is the last available HELiOS patch containing the same database 
subversion as the HELiOS version that was originally released with the corresponding Major Release. The 
advantage of this is that you will not need to update the database as well thanks to the simultaneous 
installation of HELiOS.  

If the Autostart function has been deactivated in the operating system, it is mandatory for the installation of 
HiCAD to start the setup.exe file from the root directory of the DVD; only in this way it is ensured that the 
version will recognize the operating system, and that the matching HiCAD version will be installed. 

In the installation wizard, click the Standard Edition button, which opens a mask with various selection 
options for software components. 

 

Leave this selection mask open, so that you can select the desired components one after the other. 

Click the HiCAD and HELiOS button to start the installation.  

https://wiki.isdgroup.com/display/DOW/Download+Area
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First, important information about data compatibility will be displayed. Please read this information carefully.  

If the installation program finds an already installed HiCAD Version, this will be indicated in a corresponding 
dialogue window:  

 

Activate the Update Installation option and click Next. 



Important Notes on Updates 

 78 

 

Select an installation directory.  

 

You can help us increase the user-friendliness of our products even further. To participate or terminate your 
participation, please activate the corresponding checkbox. 

You can terminate your participation at any time by choosing Help > Customer Feedback, and selecting the 
corresponding checkbox.  

 

Please read the Notes on Hardware exchange carefully. Accept the notes and click Next.   
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You can now start with the installation or modify the Extended Settings, e.g. for the user configuration, the 
catalogues, or HiCAD with HELiOS. 

 

In the Configuration Database, customer-specific settings for various features such as dimensioning, 
annotations, workshop drawing creation or fitting of vertical ladders are stored. When making an update, 
customer-specific settings can be applied. In addition, values that have not been modified by the user will 
automatically obtain the updated pre-settings.  

Depending on the selection in the Parameter configuration, the settings stored in the CSV file, too, will be 
applied. In a CSV file it is, amongst other things, specified which files (e.g. HiCAD part masks or template 
masks for annotations) are to be copied to the sys directory. When performing an Update, various system 
files in the HiCAD sys directory will be replaced with the files supplied in the HiCAD templates directory 
which have been designed especially for a working with the selected module and the activated checkboxes 
(e.g. …DSTV or Management + BIM). The standard CSV files are located in the templates directory of the 
HiCAD installation. CSV files are configuration templates that you can create and edit with Microsoft Excel 
(please see Online Help). 

Parameter configuration: No templates is activated by default. You can also change this setting 
subsequently, via the programs ..exe/ParKonfigComp.exe (for the workstation) and ..exe/ParKonfigUser.exe 
(for the User). 
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The execution of the CatalogueMaker serves the purpose of specifying which standard series are to appear 
in the standard part catalogues (currently standard series are available for DIN, ISO, EN, ANSI and JIS); the 
selection of standards in the CatalogueMaker only influences the display of standard parts, but not their 
availability; the availability is still controlled via license selection in the ISD License Manager.    

In case of updates, the existing configuration will be applied, and the CatalogueMaker will not be started 
automatically. If you want to add standards to the catalogues, the program can be called via Start > All 
Programs > ISD Software und Systeme GmbH > Administration.  

 

In case of a new installation of HELiOS you can specify an arbitrary name for the system data source. In 
case of an update, the existing data source will be offered. User and Password will be identical with the 
ODBC login.  

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address 
input field, and the Server Port of the Vault Server in the Port input field. You already entered both during 
the installation of the Vault Server.  

If you have not installed the Vault Server yet, you can do this now: Choose HELiOS Options > Database > 
General > Vault Server  .  

During an update installation it will be checked whether the existing HELiOS version is newer than the one 
on the DVD. If this is the case, the HiCAD installation will only update the non-HELiOS files. The HELiOS files 
are those that would be supplied by a standalone installation of the HELiOS Desktop, minus the 
hicadcommons contained therein.  

If you want to process your print jobs via the ISD Plot Management, you need to install one PrintClient on 
each workstation. Activate Use Spooler. In the Server field, enter the network name of the computer on 
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which the Spooler is installed. The Spooler collects the print jobs and processes them, taking your settings 
into account.  

Individual settings for the HELiOS surface can be transmitted to additional users and computers. To do so 
create a ZIP file in HELiOS via View > Settings > Export. During the installation you can select and import 
the surface configurations for the HELiOS desktop under UI configuration.   

 

The availability of interfaces with HELiOS depends on the programs that are installed on your computer. 
With the exception of the HELiOS interface, you can only use 32Bit versions with HELiOS 32Bit, and 64Bit 
versions only with HELiOS 64Bit. For MS Office it is generally possible to use a 32Bit Office with HELiOS 
(64Bit). However, for old BOMs an additional, special ODBC connection will be required. In such cases, 
please contact our Consulting team.  

Multiple selections are also possible. The HELiOS functions will be integrated in the programs that are linked 
to HELiOS. 

 

 Please note:  

 A compatibility matrix of the CAD systems can be found in the Wiki, at Product Know-how > FAQ > 
System & Hardware > HELiOS Desktop. 

 

 
If you have installed LogiKal on your computer, you can enter the installation directory here. 

https://wiki.isdgroup.com/display/FAQ/HELiOS+Desktop
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The Activate license administration tools must be activated for the installation of server licenses.  

Click Save to save the Extended Settings to an INI file. If you place the INI file in the installation directory 
when installing server licenses, the settings will be applied.  

As soon as you exit the Extended Settings dialogue with OK, the installation will be started. 

 

 Please note: 

In HiCAD, at Settings > Further directories you can set the paths for the database of the Configuration Editor, 
the Catalogue directory and LogiKal. These paths are located in the Windows Registry at 
HKEY_LOCAL_MACHINE\SOFTWARE\ISD Software und Systeme\HiCAD\nnnn.n.  
nnnn.n is the HiCAD version number, e.g. 2400.0. 

 

Close the Extended Settings dialogue window with OK and click Install. 

If you have not activated a new license yet, the following message will be displayed:   

 

Click Continue anyway to start the installation.  

Towards the end of the installation you can specify the procedure for the updating of the catalogue files. If 
you select Cancel, the catalogues will not be updated. 

Please remember that HiCAD will check the version of the utilized version upon HiCAD start. If the catalogue 
directories are old there is a risk that HiCAD will search for catalogue entries which do not yet exist in the old 
catalogues. One example of this is the Textures that were integrated in the catalogue some time ago. If these 
are missing in the catalogue, you will have no access to these Textures in HiCAD. Use the 
CatalogueUpdate.exe program in the HiCAD EXE directory to update the catalogues.  
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Specify the desired settings and click Update. 

After successful updating, the update information for the replaced files will be shown in a dialogue window. 
The old files will be preserved and renamed, e.g. 0.mac > 0.mac.2402. 

 

Click Save to save this list to a directory of your choice. Click OK to continue with the installation.  

 

Click Finish to complete the HiCAD installation.   
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If you have already activated the new Server License before the installation, you can start HiCAD now 
(Standard Configuration).  

If you have a local license you need to activate it first before you can start HiCAD.  
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6.4 Data Compatibility HiCAD/HELiOS 2019 (Version 240X.x) 
Please note that no changes are made to the HiCAD data format and the HELiOS standard database within 
major releases. This means that all patches and service packs of a version (e.g. 2400.x, 240X.x) will be 
using the same data format, and no HELiOS update will be required. 

 

 When updating from older HiCAD versions to version 240X.x, please note the information given below. 
Updates to version 2019 are only possible from version 2017 (version 220X) or 2018 (version 230X).  

 

Update from version HELiOS-Update Changed HiCAD data format 

HiCAD 2017 (Version 220X)    

HiCAD 2018 (Version 230X)   

 

 Please note: 

 If a HELiOS update is necessary, older HiCAD, respectively HELiOS versions have no access to the 
database any more. All workplaces need to be converted at the same time. 

 If the HiCAD data format has been changed, drawings and parts cannot be loaded with the older version 
if they were saved with the new version. 
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6.5 Perform Installation 
The installation of version 2019 can be carried out by a technician of the ISD or by the customer.  

In this context, please note the following recommendations by the ISD:  

» HiCAD without HELiOS 

 Update of version 2018 or 2017 to version 2019: Can be carried out by experienced users with 
sufficient background knowledge.  

 Update of version 2016 (or older) to version 2019: An update is not possible. The update 
installation from version 2008 (or older) additionally included a data conversion from ANSI to 
UNICODE format. Please contact our Consulting team.  

» HiCAD with HELiOS 

 Update of version 2018 or 2017 to version 2019: An installation by the ISD is recommended. 

 Update of version 2016 (or older) to version 2019: An update is not possible. The update 
installation from version 2008 (or older) additionally included a data conversion from ANSI to 
UNICODE format. Please contact our Consulting team. 

» 3rd party CAD with HELiOS 

 Update of version 2018 or 2017 to 2019: An installation by the ISD is recommended. 

 



Important Notes on Updates 

87 

6.6  New File Format for 2-D Files 
Similar to the KRA files in 3-D there are now 2-D figure archives with the filename extension .FGA. This 
contain the previous 2-D data (.FIG), the DB attributes (.FIG.DBA2) as well as the attribute container data 
(.FIG.ATC) and replaces the former 2-D files. Moreover, the new FGA format allows the displaying of 2-D 
files in HiCAD Viewer and also contains the 2-D HCM files. 

  

HiCAD 2017 comes with the new 2-D figures archives with the file name extension .FGA. Please use only 
this new .FGA format for conversion of existing 2-D .FIG files! For this purpose, use the new 
Converter_FIG_To_FGA.exe tool in the HiCAD\exe directory.   

When updating from HiCAD 2016 or older all standardly supplied 2-D parts (e.g. drawing frames) in the 
different installation directories will be converted from FIG to FGA by default during the installation. The data 
in the original state will be saved in a folder (resp. a ZIP archive) in the scene and catalogue directory. The 
converted files will be documented in a LOG file.       

When creating an interface between HiCAD 2017 and HELiOS, you will be prompted to update the 
databases after a new installation or an update installation. The search for and management of 2-D parts will 
only be possible after conversion of the database and the existing .FIG files with the above mentioned tool.  

 

If you are managing your HiCAD files with HELiOS a message will appear after an update or a new 
installation from HiCAD 2017 when you start HiCAD 2017 as administrator:  

 

By clicking Yes you convert the files to the database. This means that the 2-D part name contained in the 
data will be changed from *FIG to *.FGA. Moreover, the database now only searches for FGA files. 
Therefore, you also have to convert the 2-D parts into FGA files by using the Converter_FIG_To_FGA.exe 
program.     

If you have installed HiCAD 2017 or higher for testing purposes, you will have to click No when the message 
appears. Older HiCAD versions (before HiCAD 2017) cannot load FGA files. A database conversion cannot 
be undone.  

After the conversion the following message appears: 

 

Now start the Converter_FIG_To_FGA.exe program to convert the 2-D parts.  
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Folder to scan  
Enter the path of the folder that should be converted. Via this symbol  
you can select the folder in the Windows Explorer.  

The folder will only be evaluated if there is an activated checkbox  
behind Folder to scan.  

Filegrup.dat  In order to search the directories in the Filegrup.dat for FIG files the 
checkbox behind Filegrup.dat has to be activated. 

All directories from the Filegrup.dat that are marked with a tick  will be 
considered when searching for FIG files. 

 Create backup (zip)  If you have activated Create backup a ZIP file with all selected FIG files will 
be created. 

 Overwrite existing FGA If you have activated the Overwrite existing FGA option, existing FGA files 
will be overwritten if he names are identical with the converted files. 
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Folder backup and log Enter the path for the backup and log file. 

Scan for *.FIG By pressing the Scan for *.FIG  button you start the search for FIG files in 
the selected folders. 

Convert FIG -> FGA Via Convert FIG -> FGA you start the conversion. In the process all *.FIG, 
*.FIG.DBA2 and *.FIG.ATC will be deleted. 

After the conversion the number of converted files will be displayed. Furthermore, the number of defective 
converted files will be shown. Further information regarding the error can be found in the LOG file.  

 

6.6.1 Installing the Converter_FIG_To_FGA 
Start Windows to install the Converter_FIG_To_FGA. If Windows is already open, close all other applications. 
Insert the DVD in the drive, which automatically starts the installation wizard. Follow the installation 
instructions on the screen. 

In the installation wizard, click the Standard Edition button, which opens a mask with various selection 
options for software components. Please leave this selection mask open, so that you can, one after the 
other, install the desired components. 

 

Select FIG-FGA Converter.  
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Specify the installation directory for the software. 

 

Click the Install button.  

 

After a successful installation the Fig2FGA Converter can be found in the program directory and can be 
called up in HiCAD/HELiOS. 
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6.7 Automatic Installation 
The automatic search for and installation of HiCAD updates (Hotfixes). For this you require the program 
ISDUpdateSvc.exe, that you can either activate during installation of HiCAD or install via the Windows 
Control Panel afterwards. 

 

6.7.1 Installation of ISD Update Service 

 

During installation you can go to Extended settings > General and checkmark the Activate ISD Update 
Service option to activate the automatic search for Updates on the ISD Server. You can also activate or 
deactivate this option afterwards via the Windows Control Panel.   

 

In the Windows Control Panel, choose Programs and Features, right-click on HiCAD and choose Change.  
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Checkmark the Activate the ISD Update Service and click Next. After all options have been queried, click 
Change.  

After successful installation, the program ISDUpdateSvc.exe will be located by default in directory 
C:\Program Files\ISD Software und Systeme\ISD Update Service. 
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6.7.2 How to Use the ISD Update Service  
If a Hotfix is available on the ISD Server, the following message appears at the bottom right of your screen. 

 

Click on the message or start the ISD Update Service with double-click on the Tray icon  to start the 
ISDUpdateSvc.exe program. Confirm the query in the Windows User Account Control dialogue window with 
Yes. 

 

If an update is available, click the Download button to download it from the ISD Server to your computer. If 
an update should not be displayed anymore, tick Hide  . 
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After successful download oft the Hotfix, click Install.  

 

Confirm the Windows Security Warning with Install. 

Follow the instructions on the screen to install the Update. 

The HiCAD Info window displays the current HiCAD version number (including build number) as well as the 
numbers of any installed hotfixes. To show the info window, click on Help Topics and Information at the top 
of the HiCAD Ribbon and then select HiCAD. 
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6.7.3 Settings 

 

Via the Settings button you can specify the download directory for Updates and a time interval for the search 
for updates. 

You can use the  icon to start the search for Updates manually.  
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6.8 Manual Registration of the Multi-CAD AddIns with HeliosCouplings.exe 
If you use both HiCAD and HELiOS on your system in mixed operation it is not possible (as opposed to the 
standalone version of the HELiOS Desktop) to establish an interface between HELiOS and further CAD or 
CAE software via an update or modification installation.  

To do so you can use the HeliosCouplings.exe tool (in the /exe/ directory of the HiCAD installation).  

It can be used to activate interfaces with AutoCAD, Inventor, SOLIDWORKS or EPlan.  

 

Tick the checkboxes of the required software and confirm with OK. The interface will then be activated. 

The respective software has to be installed in the system.  

 

https://help.isdgroup.com/help/1033/2017/helios/helios.html#Administration/HeliosCouplings.htm
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6.9 CatalogueMaker 
The CatalogueMaker is called automatically by the installation program in case of a new installation.  

It specifies which standard series is to be shown in the standard part catalogues (at the moment standard 
series are available for DIN, ISO, EN, ANSI and JIS). The selection of the standards in the CatalogueMaker 
influences the display of the standard parts only, not their availability. This will still be controlled by the 
license selection in the configuration menu. 

The existing configuration will be taken over automatically in case of an update; the CatalogueMaker will not 
be started automatically. If you want to add standards to the catalogues, the program can be called in the 
ISD program group in the start menu via “Administration". 
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6.10 Material Manager  
The Material Manager (materialmanager.exe) that enables a taking over of materials from Catalogue Editor to 
HELiOS needs to have the same database schema as HELiOS. Therefore the Material Manager will also be 
updated.  

 

 



Important Notes on Updates 

99 

6.11 Important Notes on Plant Engineering and Pipeline Planning 
 

If you have used the HiCAD modules  Plant Engineering or Pipeline Planning with a HiCAD version older 
than Version 2016, it is mandatory that you read the information on update procedures given in the Online 
Help and also in the PDF document "Plant Engineering/Pipeline Planning – Notes on Updates". 

 

 

 

 

https://help.isdgroup.com/help/1033/2016/hicad/hicad.de.html#../Subsystems/hicadanl/Content/update/anl_update.htm
https://help.isdgroup.com/help/1033/2016/hicad/hicad.de.html#../Subsystems/hicadanl/Content/update/anl_update.htm
https://help.isdgroup.com/helponline/1033/2015/hicad/hicadanlupdate.pdf
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7 Licensing  
HiCAD/HELiOS can be activated via three license types:  

» Network licenses 

» Standalone licenses (local licenses) 

» Commuter licenses 

 

 In the HiCAD directory DOCU you can find an Online Help for the Licence Manager. You start the Help by 
calling the LICENSEMANAGER.HTML file in the folder Docu\tools\Licensemanager.  

In the ISD Wiki you can find the PDF document Use Case: Checkout Licenses at Product Know-how > 
Whitepaper. 

 

7.1 General Information about Licensing 
Local (Workstation-Specific) Licensing 

If you choose local licensing, the activation will be directly locked to the hardware of the workstation on 
which your HiCAD and HELiOS Desktop program is installed.  

The ISD will send you an E-mail containing the Entitlement ID for local licenses (standalone).  This ID will be 
required for the activation and deactivation of the licenses and software modules. Please keep the 
Entitlement ID! Without this ID you cannot activate or deactivate any licenses! In case of a defect, no 
reconstruction of licenses will be possible without the Entitlement ID!  After installing HiCAD/HELiOS, you 
activate the licenses by means of the License Activator in the ISD License Manager. 

 

Network (Server-Controlled) Licensing 

If you choose network (server-controlled) licensing, the license will be directly locked to the hardware of the 
server that centrally manages the HiCAD/HELiOS licenses. These licenses can be used on any workstation in 
your network that is connected to this server.  

The ISD will send you an E-mail containing the Entitlement ID. If you have several network servers, e.g. at 
several locations, you will receive one Entitlement ID for each network server. This ID will be required for the 
activation and deactivation of the licenses and software modules. Please keep the Entitlement ID! Without 
this ID you cannot activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will 
be possible without the Entitlement ID!  You activate/deactivate the network licenses by means of the 
License Activator in the ISD License Manager.  

Individual licenses can be checked out from the server and locked to a workstation within or outside the 
network (so-called “commuter licenses”). This enables you to continue working at a different location, 
without being connected to the license server (unless your HiCAD/HELiOS installation requires a connection 
to a database server).  For this purpose you define a specific period during which you want the license to be 
available on a selected workstation. For this period, this license will be blocked on the license server. After 
expiry of this period, the license will be made available on the license server again. It is also possible to 
manually return this license to the server before expiry of the defined period, if the workstation is connected 
to the server. Licenses for one workstation can be checked out for at least one day, with the counting 
beginning at 1:00 AM on the day following the checkout date.   

If you want to replace/exchange your license server, you need to deactivate all licenses first. 

 

 A static IP address is required for correct operation of the license server! 

 

https://wiki.isdgroup.com/display/wpaper/Whitepaper
https://wiki.isdgroup.com/display/wpaper/Whitepaper
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Practical Examples of Network Licensing 

» Let us assume that three licenses have been activated on your server. Monday morning (11.00 am) you 
suddenly need to see a customer for design tasks, and you know that you will still be on-site at the 
customer’s facility on Tuesday. You therefore check out a license for 24 hours on 11.00 am. This 
means that you can use this license until Tuesday night, 11.59 pm, from your mobile workplace. After 
expiration of this period, the license is automatically made available again on the server. If you manage 
to finish your work on Tuesday at midday, you can go back to your office and return the license to the 
server somewhat earlier. 

» Similar situation as the one described above, with the difference that you are not in your office on 
Monday, 11.00 am. In such cases you can generate a hardware ID, enabling your colleagues in the 
office to check out a license for you. This license is sent to you by E-mail and can then be activated. In 
contrast to the previous example, this license is exclusively available to you for a fixed period of time and 
cannot be returned to the server before expiration of this period.  

 

If you activate a license while the WLAN card is switched on, this license will only be valid and visible when 
the WLAN card is switched on. If, however, the license is activated while the WLAN card is switched off, the 
license will always be valid, no matter whether the WLAN card is switched on or off.  

In the ISD Wiki at Product Know-how > Whitepaper you can find the PDF document Use case: Checkout Licenses. 

 

https://wiki.isdgroup.com/display/wpaper/Whitepaper
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7.2 Network Licenses 
To be able to use network licenses, a License Server needs to be installed on a computer without 
HiCAD/HELiOS.  

The license server enforces and manages licensing in multi-user environment. It keeps track of all the 
licenses and handles requests from network users who want to run a HiCAD/HELiOS application, granting 
authorization to the requesters, or denying requests if all licenses are in use.  

The license server must not be installed on the same computer on which an ISD software product (HiCAD, 
HELiOS) is installed, as both product share system data concerning the licensing information. Formerly, 
such parallel installations of license servers and ISD products were performed in cases where a customer 
occasionally wanted to transfer the license to another computer (Remote Commuter License).  

 

 Please note:  

 As of HiCAD 2012 (Version 1700), parallel installations of license servers and ISD products (i.e. on the 
same computer) are no longer covered by the warranty. The ISD group advises you strongly not to 
perform such installations.   

 A static IP address is required for a correct operation of the License Server! 
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7.2.1 Server Installation 
The SafeNet License Server is installed from the HiCAD DVD. Start Windows. If Windows is already open, 
close all other applications. Insert the DVD in the DVD drive. The installation wizard will be started 
automatically. In the installation wizard, click the Standard Edition button, which opens a mask with various 
selection options for software components.   

 

 If you want to perform a HiCAD update to Version 2019 and use a license server (i.e. work with network 
licenses), you require Version 8.6.2 of the SafeNet License Server. If you have installed an older version, you 
need to uninstall it before re-installing the SafeNet License Server. 

 

Click the SafeNet License Server button to start the installation.  
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After successful installation you will find the Server (Sentinel RMS License Manager) under Services. From 
here you can also start and end the License Server.  

 

 

7.2.2 Client Configuration 
To ensure that the HiCAD/HELiOS Client finds the correct License Server, an environment variable 
LSFORCEHOST should be set on each Client using network licenses. The value HOSTNAME, respectively 
the IP address of the License Server is assigned to the variable. 
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7.3 Licensing via Entitlement ID (License Activator) 
Thanks to the enhanced ISD License Manager the communication between the customer and the ISD could 
be facilitated significantly.  

 

 For the activation of HiCAD/HELiOS 2019 the ISD License Manager 4.0 is necessary. 

 

7.3.1 AutoRequest Licenses  
When acquiring a HiCAD/HELiOS license, you will obtain one Entitlement ID for local licenses (Standalone) 
and another one for network licenses (Network). If you have several network servers, e.g. at different 
locations, you will obtain one Entitlement ID for each network server. These numbers will be required for the 
activation and deactivation of the licenses and the software modules.   

 

 Please keep the Entitlement ID! Without this number you cannot activate or deactivate licenses. In case of 
a system crash a reconstruction of the licenses cannot take place without the Entitlement ID! 

 

After installing HiCAD/HELiOS you can find the program in the Windows Start menu at ISD Software und 
Systeme > Administration. Please note that for the execution of some functions, administrator rights are 
required.  

The range of functions of the ISD License Manager depends on the activation of the License Administration 
Tools option. The information about this setting is entered in the Registry and can also be changed there 
subsequently if desired (please contact the Hotline).   

 

 To activate/deactivate Network Licenses, always start the ISD License Manager via the Windows Start 
menu: Select Start > All programs > ISD Software und Systeme GmbH > Administration. To avoid errors when 
activating/deactivating licenses, perform an update of the new ISD License Manager and/or the License 
Administration Tools beforehand. 
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Activate the License Activator tab and enter the Entitlement ID, your E-mail address and your Password. 
New customers obtain their password from the ISD Hotline. With this password you can also access the 
Download Area.  

 

After entering the data, click Login. The ISD License Manager connects to the ISD License Server and the 
acquired licenses will be displayed.  

This process may take several minutes. You can then activate the licenses. 

 

7.3.2 Activate Licenses 
After successful login, the number of available licenses and the number of acquired licenses are indicated 
next to each module. Select the modules to be activated and click Activate to start the activation. For Server 
Licenses the modules are already pre-selected! 

 

After successful activation a message showing you that all licenses have been successfully activated will be 
displayed:  
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You can then log out and start working with the HiCAD/HELiOS modules. 

In addition, you will receive an E-mail informing you about the deactivated modules.  

For Network Licenses, all modules will always be activated or deactivated (for further information about the 
operation of the License Manager, please read the Online Help for the License Manager. 

 

7.3.3 Deactivate Licenses  
A deactivation of licenses for modules will be required in the following situations:  

» Exchange of hardware or changing of hard disk partitioning 

» Update of the operating system (e.g. from Windows 7 to Windows 8)   
For updates within one version no deactivation will be required. 

» Transfer of local modules from one workstation to another 

» Acquisition of further modules, or return of hired licenses 

» Switch from local licenses to network licenses 

Please note the following: All workstations with modules having the same Entitlement ID need to be 
deactivated completely before a redistribution of the module licenses can take place. 

Close all HiCAD/HELiOS applications before deactivating local licenses or logging onto the License Manager. 

After starting the ISD License Manager the activated modules will be highlighted in a different colour. Click 
the Deactivate button to revoke the activation of the modules.  

 

A selection is not possible, as you need to deactivate all modules, no matter whether local licenses or 
network licenses.  

 

 The deactivation must not be disrupted, e.g. by a logout or the closing of ISD License Manager! 

 

After successful deactivation the following message will be displayed:  
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7.3.4 Trial Licenses  
If you select Display trial licenses after logging in, you will be also shown, besides all trial licenses with a 
limited period of validity, all purchasable licenses which are not simultaneously available as trail licenses.  

 

7.3.5 Reconstruction of Licenses  
As all licenses are stored on the ISD Server, you can, in case of an interrupted connection or an accidental 
deletion of licenses, restore all licenses by logging in with your Entitlement ID. The restoring will only function 
if the hardware was not changed (see 4.2.3.3 Deactivate Licenses). 

 

7.3.6 Notes Regarding the Use of Mobile Computers (Laptops) 
If you use a computer with WLAN card, Please make sure that the WLAN card is either always switched on, 
or always switched off.  
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7.3.7 Floating Licenses 
If you have acquired a HiCAD Extension Module with the property Floating-able at runtime, you can 
activate/deactivate them during the current HiCAD session. The HiCAD Selection dialogue window will be 
displayed. 

 

If one Extension Module is (de)activated, the Extension Modules that are prerequisites for this module will 
also be (de)activated (if they are also floating-able at runtime).  
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7.4 Commuter Licenses 
Commuter licenses enable you to use network licenses even if the workstation is not connected to the 
Server. There are two ways of receiving commuter licenses: 

» Via direct checkout from the License Server 

» Via checkout from License Server, without network connection 

 

7.4.1 Direct Checkout from License Server 
Start the ISD License Manager 4.0 application (while a connection to the Server still exists). Switch to the 
Commuter License tab.  

 

If you have set the system environment variable LSFORCEHOST, the entered License Server will be 
displayed as the preselected server upon start. Use the Search network button to automatically search for 
License Servers.  

Expand the tree structure of the found Server by a click on the “+”-sign. The result looks as follows:  

 

Select the required licenses by activating the corresponding checkboxes on the left hand side. On the right 
hand side, information on the selected license is displayed.  

In the Commuter license: Validity in days field, you enter the number of days that you want the commuter 
licenses to remain checked out from the Server. The maximum number of days is 60. By default (or if a “0” 
is entered), the value is set to 1.  
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 For reasons of safety you should check out the licenses only for the required period! If a commuter 
license is lost, e.g. because of theft or a defect of the client computer, the license on the Server cannot be used 
any more before expiry of this date! 

 
After entering the expiry date for the commuter licenses, click the Update licenses button. 

Commuter licenses are checked out from the Server. 

 

All selected licenses are now checked out from the Server and you possess all rights on your computer for 
the specified validity period for the commuter licenses. This means that you are enabled to work network-
independent. The checked out licenses are no longer available to the other computers on the net.  

You can however also return the commuter licenses before their expiry date. To do this, you need to connect 
to the Server, deactivate the checkboxes on the left and click the Update licenses button. All licenses are 
now made available on the Server and locked on your computer, i.e. you can now only use HiCAD/HELiOS if 
there is a connection to the License Server. The licenses made available again can now also be used from 
other workstations. 
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7.4.2 Checkout from License Server, Without Network Connection 
Commuter licenses can also be drawn from the License Server without an existing network connection.  

 

 Please note that administrator rights are required.  

Commuter licenses checked out in this way cannot be returned to the License Server! This means that the 
commuter licenses that have been checked out from the Server are only (automatically) made available again 
after their expiry date. 

 

Several steps are required for this, by the administrator having a network connection to the License Server, 
as well as by the Client having no network connection to the License Server.  

The Client starts the ISD License Manager tool, switches to the Remote Locking Code tab and sends the 
generated character set to the administrator (via E-mail or over the phone). 

 

The administrator starts the ISD License Manager and switches to the Commuter License tab. The License 
Server is selected, and the required licenses (modules) are activated in the left window. To checkout a 
remote commuter license the administrator now needs to activate the Check out authorisation for remote 
computer checkbox. Administrator rights are required. 
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A click on the Update licenses button opens a new dialogue window, in which the administrator enters the 
character set received from the Client.  

 

After selecting OK, another dialogue opens, in which you enter the target path and the file name for the 
licenses to be swapped out.  

 

Select OK to check out the commuter licenses from the License Server and swap them out to a file, e.g. 
RemoteLicCode.lic. 

 

The successful checkout will be confirmed. The administrator then sends the file, RemoteLicCode.lic, to the 
Client.  

After receiving the file with the commuter licenses, the Client starts the ISD License Manager again and 
activates the Install Remote Authorisation Code tab. Here the received commuter licenses can be installed 
directly via file selection or via copying of the file contents.  
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Click the Install... button to install the commuter licenses on the Client.  

 

After successful installation, switch to the Standalone License Info tab. Press the Activate key. You are now 
informed which licenses are installed locally on the computer.  
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7.5 License Configuration 
Some cases may require the use of only certain specific licences on a computer. Example: On the License 
Server, HiCAD creator and HiCAD solution licences are available. On one Client, HiCAD is to be started with 
a HiCAD creator license; on another Client, HiCAD is to be started with a HiCAD solution license. If the 
selected license is no longer available, an application start is no longer possible.  

 

 If there are several basic modules in a standalone (workstation) license (to which also the Commuter 
Licenses belong), it is mandatory to make a pre-configuration and save it as workstation configuration. If no 
pre-configuration is possible, the HiCAD/HELiOS configuration tab will be displayed before the start of 
HiCAD/HELiOS. If the selected configuration does not match the available licenses, a warning message will be 
issued, with a list of available licenses. After this, the configuration selection will be displayed again. 

 

7.5.1 License Configuration HiCAD 

 

On the HiCAD Configuration tab of the ISD License Manager tool you have the option to save a workstation 
or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of this computer. When 
HiCAD is started, the selection window is no longer displayed (administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. When HiCAD is 
started, the selection window with the saved configuration is always displayed.  

These license configurations apply to network licenses and standalone (workstation) licenses.  
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7.5.2 License Configuration HELiOS 

 

On the HELiOS Configuration tab of the ISD License Manager tool you have the option to save a workstation 
or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of this computer. When 
HELIOS is started, the selection window is no longer displayed (administrator rights are required for 
this).  

» Save as user configuration: This configuration is only saved for the current user. When HELiOS is 
started, the selection window with the saved configuration is always displayed.  

These licence configurations apply to network licenses and standalone (workstation) licenses.   

 

 



Licensing 

119 

7.6 Server Monitor 
With the ISD License Manager tab Server Monitor you are allowed (as far as you are able to execute ISD 
License Manager) to view detailed information as follows: 

» Listing of available modules with module description (e.g. “Element Installation”). Relevant is the 
License Server which the user is connected with. 

» Apart from the module description, the maximum amount of available licenses as well as allocated 
licenses is displayed. 

» You can open up the available modules and here the users using the respective license are displayed. 

» The listing of users using a license also shows which user is connected with the License Server and 
which user uses a Commuter License. 

By listing the licenses you can easily see who blocks licenses and, for example, easily speak to them in case 
if you need a license. 

In the installation program, the tab Server Monitor is activated by clicking on the option Activate License 
Administration Tools. 

 

 

7.7 Theft of a Workstation 
The user is responsible for appropriately insuring the HiCAD/HELiOS workstations against theft. If desired, 
we can tell you the reinstatement value of your software. If a workstation is stolen, you will need a new 
license. In such cases, please send us the police report of the theft first. We will then provide you with a 
license for a limited period of time, and submit an offer for a new license to you. The ISD will send you the 
new license after clarification of the case with your insurance and receipt of your payment for the license 
fee. 
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8 HiCAD at a Glance 
HiCAD is a universal CAD system with true 2-D/3-D associativity, innovative functions, comprehensive 
industry solutions and an integrated PDM component. Up-to-date working techniques and numerous 
automatisms help you abridge routine tasks. Simulation and analysis tools enable you to detect and prevent 
possible collisions within your product models at early design stages.  

» Performance characteristics:  

 Microsoft Windows standard and GUI based on the Windows “Ribbons” technology 

 Combined working in 2-D and 3-D  

 Assembly-oriented design engineering providing top performance even for very large assemblies  

 Transparency and clearness thanks to convenient search functions, filters and multiple selection 
options  

 Extensive symbol and standard part catalogues 

 Simulation and analysis tools  

 Standardisation and automation 

 Direct modelling and parametric design 

 Integrated product data management with HELiOS  

 Data transfer from other systems (CATIA, ME10, STEP, DXF, DWG etc.)  

 BOM-creation, PPS interface, transfer to NC programs  

 Comprehensive industry solutions for Steel/Metal Engineering, Plant Engineering, Sheet Metal 
processing and Plant Engineering 

 Individually extendable due to a modular structure  
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9 First Steps in HiCAD 
9.1 Start HiCAD 
You start HiCAD by:  

» using the Windows task bar (Start) to choose the Programs folder and then clicking the HiCAD icon 

 in the ISD … menu, or   

» by clicking the HiCAD icon  on your desktop.  

Once you have started HiCAD, the input window for License Management is initially displayed, followed by 
the HiCAD Start Centre (provided that it has not been deactivated).  

If you use HiCAD in conjunction with HELiOS, a login may be required to start HiCAD.  

In order that you can take full advantage of the numerous new features and enhancements offered by 
HELiOS 2016, a News window with videos explaining the new and changed HELiOS functionalities will be 
shown upon HiCAD start. We will provide you with such videos with each Major Release and Service Pack to 
keep you constantly informed in the best possible way. 

You can configure the display of the News window at the bottom left. We recommend using the Show most 
recent news option to ensure that you will never miss any news about HELiOS.  

If you have selected Never show  option, you can call the News window again at any time and change the 
display option by clicking on the “?” symbol at the top right and selecting Show news.  

 

 During the launch of HiCAD it is checked whether the required version of .NET Framework is actually 
installed. If this is not the case, an appropriate error message is issued and HiCAD is closed. 
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9.2 DLL Check  
Due to entries in the Windows-Registry, more and more libraries from third parties (DLL file) are integrated 
when HiCAD is launched, e.g. in order to capture messages or outputs to the screen. Some examples are 

» Virus scanners, 

» PDF programs,  

» Programs for the recording of screen activities,  

etc. These files can sometimes cause problems.  

When you start HiCAD, it will first be checked whether DLL files are assigned to the Registry value AppInit in 
the Registry key  

 HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows (64Bit) 

 HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows 
NT\CurrentVersion\Windows (32Bit) 

If this is the case, the following message will be displayed: 

 

Activate the Suppress message checkbox if you do not want this message to be displayed upon future 
HiCAD starts. Also inform your administrator about the message. The message will not reappear until the 
Registry value changes again, i.e. not until other DLLs will be loaded!  

If you want to completely suppress the message, you can also set the registry value CheckBoxState in the 
registry key  

HKEY_CURRENT_USER\Software\ISD Software und Systeme\HiCAD [year version, e.g. 2019]\Splash 
Screen  

to 1. 

 

 Be careful when editing the Registry! The entering of incorrect values or the deleting of values can 
destablilize the operating system! 
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9.3 Close HiCAD 
To close HiCAD,  

» click the Close icon  or 

» click the ISD button and select End.  

If any HiCAD drawings are still open at this point, you have the option to save them. You distinguish between 
the current drawing that you see on the screen, and the other, still open drawings. If a drawing file with the 
same name already exists, you can save the drawing under a different name, or overwrite the existing 
drawing. Please note that no backup copy of the file will be created in such cases!  

 

 When you close HiCAD, all files, with the exception of the automatic data backups, will be removed from 
the TEMP sub-directory of your HiCAD installation. 
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9.4 The Start Centre 
When you start HiCAD for the first time, the Start Centre is displayed, which has been designed to facilitate 
your first steps of drawing creation.  

 

Please note:  

» Click on the graphic to obtain information about the version number.  

» When you call the Start Centre again, the values that you set last will be displayed as default values.  

» The settings you have selected for the Create new drawing start action will even be used in HiCAD if 
you call the New drawing (without DB) function. 

 

9.4.1 Create New Drawing 
If you want to create a new drawing, specify whether you want to create a part drawing or an assembly 
drawing by activating the appropriate checkbox.  

» Part drawing (detail drawing)   
In a part drawing (detail drawing) you divide your drawing into main parts and sub-parts. To define the 
part structure you use so-called dummy parts which symbolise the assembly. You then assign 
assembly-relevant main parts and sub-parts to these dummy parts. Instead of dummy parts you may as 
well use the special component type Assembly.  

» Assembly drawing   
You can define 3-D drawings directly when creating the assembly drawing and - if you are working in 
parallel with HELiOS - enter them into the database. This provides significantly more efficiency, 
particularly for referencing, itemisation and BOM-creation.  
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9.4.2 Options 

» Enter drawing into database    
If you are working with HELiOS you can define here whether you want to the new drawing to be entered 
into the database. If you activate this checkbox, HiCAD will prompt you to specify the document master 
data once you exit the Start Centre. If not, you will be prompted to enter the name of the drawing file. 
  
Activate, if desired, the project to which you want to assign the drawing.  

» Scale   
Here you can preset the scale of the drawing.   

» Start mode   
Here, choose the start mode you want to be activated once you exit the Start Centre, e.g. 2-D, if you 
want to start the drawing in 2-D or 3-D Extruded solid, if you want to start your drawing by creating an 
extruded solid in 3-D.  

» Create processing planes (3-D only)   
Here you can specify which of the standard processing planes you want to create. Activate the 
appropriate checkbox.   

» View projection and View representation (3-D only)   
If you want to work in 3-D, use these functions to pre-set the model view and the view representation.  

 

9.4.3 Load Existing Drawing 
If you have chosen Load existing drawing as start mode, you can specify whether you want to load the 
drawing via the database, the Explorer or via an interface. As with a new creation, you may also activate the 
project directly. 

 

9.4.4 Switch Start Centre Display Off 
If you activate the Switch Start Centre display off checkbox and click OK to exit the Start centre, the current 
settings will apply as the default settings for whenever you start HICAD again and create new drawings. The 
Start Centre is then no longer displayed. To re-activate the Start Centre display and to change the settings, 
choose the Activate Start Centre function. The changed settings will be applied when starting HiCAD again.  

If you click OK to exit the Start Centre, the current settings are used as the default setting if, on the other 
hand, you exit the Start Centre by pressing the ESC key or the  icon, the settings are ignored.  
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10 HELiOS at a Glance 
On the way to the finished product, time expenditure, the cost situation and product quality can only be 
optimised if all departments of a company work together efficiently. This requires a well-structured and 
efficient exchange of information between the parties involved in the production process - from 
Manufacturing, Purchasing and Service to Marketing and Sales. 

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-free gathering, 
distribution and management of the data that is required for the process chain. Once saved, these data can 
be re-used within the entire company and for the complete product life cycle. HELiOS manages and controls 
all process cycles by regulating and monitoring the processing and transfer of these data. 

Thus, the know-how of the company will be used optimally, redundant work can be avoided and error 
sources will be eliminated. 

HELiOS combines Product, Process and Peripherals Management to form a single system, thus making 
HELiOS the knowledge reservoir of your company. 

HELiOS can be integrated in your overall CAD system or used as a stand-alone system, the so-called 
HELiOS Desktop. 

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific requirements.  
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11 First Steps in HELiOS 
» Program Call  

Start the HELiOS Desktop by double-clicking the HELiOS.EXE file in the \HiCAD\exe directory or via the 

program icon  on your Desktop. 

Default setting is the project-independent start. Please note that the list view in the right-hand window will 
not be shown when you start HELiOS Desktop for the first time. Select a project first and display the list view 
via View and then Lists. 

If you have not ended HELiOS correctly during your last session, you will receive an error message from the 
Vault Server.  

 

» News window 

In order that you can take full advantage of the numerous new features and enhancements offered by 
HELiOS, a News window with videos explaining the new and changed HELiOS functionalities will be shown 
upon HiCAD start. We will provide you with such videos with each Major Release and Service Pack to keep 
you constantly informed in the best possible way. 

You can configure the display of the News window at the bottom left. We recommend using the Show most 
recent news option to ensure that you will never miss any news about HELiOS.  

 

» Registration  

The HELiOS User Management is based on the User Management of Windows. If several users are 
registered with the same Windows User Name in EDBSETUP, a login mask will appear when starting 
HELiOS Desktop.  

Name and active group enable the user to login with the rights guaranteed by the User Management.  

If you select a project from the Active Project drop-down list, this project will be opened after starting 
HELiOS Desktop. If you select the project-independent setting, all documents will be displayed. 

Start the HELiOS Desktop with Login (see below).  

To ensure that a specific project will be opened after starting HELiOS Desktop, you need to specify a Start 
Project. On the Ribbon, activate the Tools tab, then select Options, activate in the dialogue the General tab 
and choose a start project. 

 

» Login  

Use the Login  function for a new login while working with the HELiOS Desktop, e.g. to work with different 
rights without having to exit the program. 

 Activate the Login  function on the QuickAccess toolbar. 

 Select a different user.   

 If required, change the active project and confirm the new settings with Login.  

 

 

mk:@MSITStore:D:/Dokumente%20und%20Einstellungen/sduempelmann.INT/Desktop/helios.chm::/AllgemeinesZuHeliosNext/Konfiguration_(EDBSETUP)/HELiOSKonfiguration.htm
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12 How to Use the Help 
The Online Help provides you with information, descriptions and examples on all functions and techniques 
which are available in HiCAD – from 2-D and 3-D to the integrated PDM functionality, Sheet Metal 
Processing to Steel/Metal and Plant Engineering.  

 

 Please note that the scope of available functions may vary, depending on the configuration level of your 
HiCAD product. This means that some of the functions described in the Online Help may not be available. 

 

The Help is available both locally (status of the installation DVD) and on the Internet (regularly updated) at 
help.isdgroup.com. Both versions of the Help can be called from HiCAD via the Help Topics and Information 
item (“?” icon on the top right of window). You can select your preferred Online Help type via ? > Help 
Settings.  

 

You call the HELiOS Help via the HELiOS Desktop Help menu item.  

 

To be able to use the Internet version of the Help, you need to register for the ISD’s new company Wiki 
once. This will not only give you access to the new Help, but also provide you with many other information 
which will be made available shortly in the ISD Wiki (Forum, Download area etc.). 

Click Sign up in the login window of the Online Help to register. If you have already been registered, enter 
your access data and click Login to get directly to the start page of the Online Help.  
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Register for the ISD Wiki 

After clicking Sign up in the Login window of the Online Help, enter the data required for the ISD Wiki in the 
dialogue window. Confirm the security prompt and click the Sign up button. 

 

After the registration the dashboard of the ISD Wiki will be displayed. A message indicates whether you have 
been authenticated as an ISD customer.  

If you could be identified as an ISD customer, you can now directly launch the Online Help using your 
registration data.  

If you could not be identified as an ISD customer, please perform the steps described in the message.  
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13 What’s New in Version 2019? 
A detailed overview of all new features and enhancements contained in HiCAD 2019 can be found in the 
What’s New? topic of the Online Help.  

You can also click on the  button in the Help.  

An overview of new features in PDF format will open if you click the  button in the Download area 
of the Wiki.   
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